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I. Executive Summary 
 

The following Instructional Design Portfolio was developed by the design team of Brice 
Jewell, Sarah LaVaute, Aaron Olson, and Astrid Wichmann, Masters of Education students at 
the School of Information Science and Learning Technology at the University of Missouri 
Columbia.  The Analysis Summary provides more detailed rationales for both the creation of the 
ED101 course and the need for revising the Netscape Composer component, as well as learner, 
environmental and task analyses of the course.  In the Design Brief, the design team’s choices of 
instructional strategies, media, and assessment items that best suit the goals and logistics of the 
course are presented.  Finally, a formative evaluation was conducted to measure the effectiveness 
of the revisions.  The results of this evaluation can be found in the Formative Evaluation Report 
followed by the Instructional Product itself and a list of References used in the development of 
this Design Portfolio. 
 
 
II. Analysis Summary 
 
A. Problem Description 

Freshman students within the University of Missouri – Columbia’s College of Education 
(COE) enter the university with greatly varying technology skills. As these freshman COE 
students enter classes they find that they are expected to know how to use several basic computer 
skills, and apply them with basic computer applications. Many classes require students to use 
Microsoft Office Suite Software including Excel, Word, PowerPoint; know how to use their MU 
Outlook Email account; be able to conduct a useful Internet search; make on-line presentations; 
identify peripheral equipment, and more. With the varying knowledge levels in relation to these 
skills, students find themselves struggling to learn software quickly, while not completing the 
related class work to the best of their ability. Additionally, instructors may have to take time out 
of their class schedule to tutor students who are struggling because of their lack of basic 
technology and computer use skills. Interviews with faculty members have resulted in the 
identification of students’ overall lack of basic computer use skills including the use of basic 
Microsoft Office Suite applications, email, and more.  

The MU - College of Education Teacher Development Committee has requested that a 
class be created to service this need, in addition to keeping with a vision that is focused on a 
movement towards technology integration in education. An on-line class that focuses on the 
basic skills needed in MU College of Education courses has been created. “ED101: Teacher 
Technology Skills” is based upon the above-mentioned skills and more. 

The macro environment involves the revision of this course’s instructional design, in 
addition to altering the facilitator’s ease of use. Because of the wide-ranging subject matter, this 
project will focus on one unit of study. The micro level focus of this instructional design will 
involve the revision of the Netscape Composer lesson, which will be evaluated for the 
Instructional Design Portfolio.  

The design team has chosen to work together with the ED101 instructional designer to 
revise the current Netscape Composer component of the ED101 curriculum. Each group member 
of the instructional design team has experience in the use of web editors, and basic HTML 
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coding. Three out of four of the group members have introductory level knowledge of 
instructional design processes, and one member has experience writing curriculum.  
 
B. Description of Instructional Needs 
 
Description of Needs Assessment: 

Before being able to determine the need for the “Creating a Web Page” unit, a needs 
assessment was first conducted to determine if the ED101 course was needed.  This needs 
assessment was conducted by the College of Education in the year 2000.  The assessment tools 
consisted of UMC-COE faculty and student surveys.  The purpose of the assessment tools was to 
determine the level of computing skills that freshman COE students possessed and the level of 
skill that professors would require of the students.  Some of the information gathered indicated 
that there was a wide range of student technology skill levels. Additionally, data collected from 
this needs assessment identified a number of skills that freshman COE students need to complete 
course work. This also provided for the COE to cross-reference this collected information to the 
International Society for Technology Education’s Performance Indicators for Teachers. Thus, 
ED101 was created to serve both the purposes of adherence to the ISTE standards, and the need 
for a technology skills class that focused on realistic needs of COE students. 

The culminating unit in the ED101 course is “Creating a Web Page with Netscape 
Composer”.  This unit consists of two lessons: Introduction to HTML and Creating a Web Page.  
A tutorial was created to teach the Creating a Web Page unit.  ED101 was intended to teach 
computing skills to freshman COE students, but its goals are to teach those skills within the 
context of the students being future educators.  In order to determine if the instruction meets the 
needs that ED101 is designed to address, a needs assessment was conducted on the Creating a 
Web Page unit.  To conduct the needs assessment, a formative evaluation was performed.  This 
evaluation consisted of interviewing one subject matter expert and conducting two one-to-one 
user interviews.  The subject matter expert previewed the instruction and the users performed the 
instruction.   

Based on the data collected from the needs assessment, it was determined that the 
Creating a Web Page instruction primarily serves as a step-by-step Netscape Composer tutorial 
and does not place the instruction within the context of the students being future educators.  This 
is the primary need that is to be addressed.  Additional needs were also identified based on the 
data gathered from the subject matter and user evaluations.  It was determined that the instruction 
does not provide enough of an introduction as to what web sites and the Internet are.  The 
instruction needs to provide more examples in order to better clarify important topics such as 
good web design principles, appropriate use of color, and appropriate site content.  A “resources” 
page needs to be created, which will provide additional information, help illustrate important 
topics, and provide an all-inclusive list of resources used in the lessons within this unit. This 
“resources” page would provide additional scaffolding as students begin to create their teacher 
web page.   More advanced information on creating and designing web sites also needs to be 
provided, including information about design, content of teacher web pages, and more.  A 
complete listing of the recommended revisions resulting from the needs assessment analysis can 
be found in Appendix B.6. 
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Problem Statement: 
The current instruction provided in the Creating a Web Page unit does not address the 

importance and need of being able to create a web page in a context that future educators will 
value and appreciate.  Therefore, the Creating a Web Page unit needs to be redesigned in order to 
meet the needs of freshman COE students as both current students and future educators. 
 
Description of Analysis Tools and Procedures: 

The needs mentioned above that will be addressed in the redesign of the Creating a Web 
Page unit were determined by conducting a subject matter expert (SME) evaluation and two one-
to-one user evaluations.  During the SME evaluation, the SME was first given an overview of the 
evaluation procedure and the goals and objectives of the instruction.  The SME then began 
reading through the instructional materials.  The SME was asked to use a “think aloud” method 
so that the evaluators could record what the SME thought as she proceeded through the 
instruction.  The evaluators recorded observations and comments made by the SME on hard 
copies of the instruction.  This method allowed the evaluators to more accurately pinpoint where 
problems occurred in the instruction.  These observations were later transferred to an observation 
log (Appendix A.1).  After reading through the instruction, the SME was asked to complete an 
attitude questionnaire about the instruction, which covered areas such as instructional design, 
cosmetic design, and functionality (Appendix A.2).  After completing the questionnaire, the 
SME was asked some debriefing questions in order to obtain further suggestions for improving 
the unit (Appendix A.3).  The data collected from the SME evaluation can be found in Appendix 
B items B.1 and B.2. 

Two one-to-one user evaluations were conducted with a female junior COE student and a 
male senior COE student.  Both users were first given an overview of the Creating a Web Page 
unit, which included the goals and objectives of the unit as well as the procedure that would be 
followed during the evaluation.  Each user was paired with one evaluator to proceed through the 
instructional materials.  The users worked through the instruction while using the think aloud 
method.  The evaluators recorded observations and comments made by the users on hard copies 
of the instruction, which were later transferred to observation logs (Appendix A.1).  After 
completing the instruction, the users completed an attitude questionnaire.  The questionnaire 
covered materials such as unit content, unit design, self-paced delivery, and unit results 
(Appendix A.4).  After completing the questionnaire, the users were asked some debriefing 
questions in order to obtain further suggestions for improving the unit (Appendix A.5).  The data 
collected from the user evaluations can be found in Appendix B items B.3, B.4, and B.5.   
 
C. Goal Statement:  

University of Missouri – Columbia’s first semester, freshman, College of Education 
students will be able to effectively and efficiently create a basic web page using the Netscape 
Composer Web Editor Program, for use as a classroom teacher. 
 
D. Environmental Scan: 
 
 System of Interest: 

The ED101 class will be created for the University of Missouri – Columbia’s College of 
Education. This class will be made a component of a freshman COE orientation course, ED100.  
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Description of Context: 
This online course will be offered via the Blackboard 5 online education platform, and be 

a component of the ED100 UMC-COE Freshman Orientation class. Students will apply the skills 
gained from this course in their course work at the UMC and in their future professions as 
classroom teachers.  

Approximately 350 freshman UMC-COE students will take this course every fall 
semester. These students will be able to access this course from any Internet connected 
computer, with the use of their assigned pin number and password. All students will have access 
to the Reflector computer lab, located in Townsend Hall, on the UMC campus. These Mac and 
PC computers run Windows 1998 are loaded with Netscape 4.7, the software needed to complete 
the “Creating a Web Page” unit.  

Presently, the ED101 administrator, Dr. Jane Howland, will oversee the course. The 
assigned ED101 Coordinator will complete specific maintenance of course content and 
information. This coordinator will oversee the graduate teaching assistants assigned to teach 
sections of the course.  
 

E. Learner Analysis: 

Target audience overview: 
 
 The audience of which these instructional materials have been created are 350 UMC-
COE pre-service freshman teachers. These teachers are: an average age of 19, approximately 85 
% female, a majority of which live on campus and a majority of which have never completed an 
online course.  
 
Cognitive Characteristics: 
 
General Aptitudes:  The target audience of pre-service freshmen teachers have average to above 
average intelligence. The majority of these students are able to reflect meta cognitively their own 
information processing. Additionally they are able to seek learning strategies to help themselves 
and they are able to use advanced study strategies.  
 
Specific Aptitudes:  It cannot be assumed that the pre-service teachers have completed an online 
course before. Additionally the students have greatly varying technology skills. 
  
Developmental Level: The target audience is at the formal operations level of reasoning. 
 
Language Developmental Level:  A majority of ED101 students speak English fluently. Students 
possess varying knowledge of technology terminology (or language). 

 
Level of Visual Literacy: It is assumed that all students can process information from graphics 
when their efforts are supported by questioning and kept focused by specific prompting.  

 
Cognitive Processing Styles: Because of the vast amount of students enrolled in this course, 
varying cognitive processing styles will be used throughout the learning process 
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Particularly Prior Knowledge: Freshman students within the University of Missouri –Columbia’s 
(UMC) College of Education  (COE) enter the university with greatly varying technology skills. 
Most students don’t have prior knowledge of creating web pages or HTML in particular.  
However, it can be assumed that a majority of freshman COE students enter ED101 with 
introductory computer skills.   
 
Cognitive and Learning Strategies: Because of the large and varying audience of target learners, 
differing effective learning strategies will be implemented.  
 
 
Physiological Characteristics: 
 
Sensory Perception: The students of ED101 do not suffer from extreme sensory impairments 
such as hearing loss and blindness to any degree greater than the general population. 
 
General Health: Since this instruction is web based, the students visually depend on screen 
monitors.  Even if the targeted users of this course are color blind, the instructions are legible.  
 
Age: As mentioned in the beginning, our target audience consists of students with an average age 
of 19 
  
 
Affective Characteristics: 
 
Interests: Students enrolled in this course have varying interest levels in furthering their 
technology skills. The students are interested in learning how to create a web page, because this 
will be one way of presenting content and instruction in their future job 
 
Motivation: It can be assumed that the students have at least intrinsic as well as extrinsic 
motivation to take this class.  Students will be extrinsically motivated because the course is 
required.  Some students experience also intrinsic motivation, because they have chosen by 
themselves to take this class.  
 
Attitude Toward Subject Matter: In general, this group of pre-service teachers will have a good 
attitude towards learning to create web pages, because they know that it is important for them to 
use web pages in instruction. 
 
Attitude Toward Learning: It can be assumed that the students have a good attitude towards 
learning since they are young learners and have recently chosen to enroll in the College of 
Education. 
   
Academic Self Concept: Varying amounts of target learners will possess a high level of 
academic self-concept and believe that they can reach their goals.  
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Anxiety Level: Varying levels of anxiety related to learning to create a web page will be 
experienced, as there are varying technological skills within the target audience. 
 
Attribution of success: The level of success will mostly depend on student effort level and 
instructional design of the unit. 
 
 
Social Characteristics: 
 
Moral development: It can be assumed that the target audience’s stage in moral development 
varies. Because of their age being an average of nineteen, and varying levels of development 
within a large group of students, the target audience may be in the conventional or post 
conventional stages of moral development.  
 
Socio-Economic Background: The Socio-economic background of the target audience varies, as 
there are such a large number of students. 
 
 
F. Task Analysis 
 
 Instructional goal:  University of Missouri – Columbia’s first semester, Freshman, College of 
Education students will be able to effectively and efficiently create a basic web page using the 
Netscape Composer Web Editor Program, for use as a classroom teacher. 
 
Type of learning: Procedural 
 
Task Analysis Type: Learning Hierarchy Analysis 
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Lesson IPA:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Definition of HTML, web page min. 
requirements, basic html tags, access 
to Netscape Composer, good and 
bad design, examples of teacher web 
pages 

Create folder for web page files. 

Create, name, and save new Composer 
document. 

Place text in new Composer document 
and format/manipulate it. 

Create numbered and bulleted lists in 
new Composer document. 

Insert horizontal lines in Composer 
document. 

Create relative and absolute links in 
new Composer document. 

Change background, text, and link 
colors in new Composer document. 

Insert image in new Composer doc. 

Preview new web page. 

Create a web page using 
Netscape Composer. 

Identify appropriate design principles 
and content for class web page 
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Lesson Objective 1: The LWBAT explain what an HTML document is, describe the minimum 
requirements of a web page, and explain some of the basic HTML tags. 
 
Lesson Objective 2:  The LWBAT create a folder to store the files for a Netscape Composer web 
page. 
 
Lesson Objective 3: The LWBAT create, name, and save a new document in Netscape 
Composer.  
      
Lesson Objective 4: The LWBAT place, manipulate, and format text in a Netscape Composer 
web page.  
 
Lesson Objective 5: The LWBAT create numbered and bulleted lists in a Netscape Composer 
web page. 
 
Lesson Objective 6: The LWBAT insert horizontal lines in a Netscape Composer web page. 
 
Lesson Objective 7: The LWBAT define relative and absolute links, and create a link to another 
web page from a Netscape Composer web page. 
 
Lesson Objective 8: The LWBAT change the background, text, and link colors of a Netscape 
Composer web page.  
 
Lesson Objective 9: The LWBAT list the image file formats that web browsers support,  
download an image from the web and save it to a folder, and insert an image into a Netscape 
Composer web page. 
 
Lesson Objective 10:  The LWBAT preview the Netscape Composer web page. 
 
Lesson Objective 11:  The LWBAT identify and apply appropriate web design principles, and 
identify and include appropriate content to include in a teacher web page. 
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Unit ICM: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
III. Design Brief 
 
 
A. Macro-Level Strategies 
 
      Terminal Objective:  

After completing “Unit 7: Introduction to HTML and Netscape Composer,” students in the 
College of Education ED101 class will be able to create web pages for their future 
classrooms that follow good web design principles and provide important and appropriate 
information for their future students. 
 

     Unit Objective 1:  
LWBAT determine good design principles, determine appropriate content for a class web 
site, create, name, and save an html document containing text, links, lists, colors, horizontal 
rules, and images using Netscape Composer as well as be able to store it in a new folder and 
preview it in a web browser. 
 
 Type of learning: Procedural Learning 
 
Macro-strategy: The macro-level strategy will be utilization-related.  The largest part of the 
instruction teaches a procedural task.  Learning how to use Netscape Composer to create a 
web page would not be efficient using an inquiry approach.  A utilization-related structure 
allows the teaching of concepts and facts, and provides resources and procedures that will be 
used in a sequential order.  The strategy is also utilization-related because the first concepts 

Unit Objective: Determine appropriate design 
principles, content,  
Create web page using Netscape Composer. 

Objective 10: 
LWBAT preview the    
web page. 

Objective 3: 
LWBAT open, name, and 
save Composer doc. 

Objective 2:  
LWBAT create new folder 
to store web page files. 

Objective 4:  
LWBAT insert, manipulate, 
format text in Composer. 

Objective 5: 
LWBAT create numbered 
and bulleted lists. 

Objective 6: 
LWBAT insert horizontal 
lines in Composer. 

Objective 7: 
LWBAT insert links in 
Composer. 

Objective 8: 
LWBAT change background, 
text and link colors. 

Objective 9: 
LWBAT insert images in 
Composer. 

Objective 1: 
LWBAT define 
HTML, basic tags, 
minimum 
requirements Objective 11: 

The LWBAT identify and apply appropriate 
web design principles, and identify and 
include appropriate content to include in a 
teacher web page.  
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that are taught are the first to be used; the instruction provides foundational information on 
web page construction and builds to more advanced topics.   
 
An inquiry-related strategy, specifically an exploratory approach, is also used minimally to 
teach good web design principles and appropriate site content. 

 
 
B. Micro Instructional Design 
 
Task Analysis 
 
Terminal Objective:  
LWBAT determine good design principles, determine appropriate content for a class web site, 
create, name, and save an html document containing text, links, lists, colors, horizontal rules, and 
images using Netscape Composer as well as be able to store it in a new folder and preview it in a 
web browser 
 
Objective 1:  The LWBAT explain what an HTML document is, describe the minimum 
requirements of a web page, and explain some of the basic HTML tags. 
 
 Type of Learning: Declarative 
 
 IPA 

1. Define HTML 
2. Define Web Browser 
3. Describe HTML tags: html, head, title, body, paragraph, bold, a href 
4. View source code  
5. View sample page 

 
Objective 2:  The LWBAT create a folder to store the files for a Netscape Composer web page. 
 

Type of Learning: Procedural 
 
 IPA 

1. Double Click My Computer 
2. Double Click [C:] 
3. Right Click on white space 
4. Click New and select Folder 
5. Change name of new folder 
6. Press Enter 

 
Objective 3: The LWBAT create, name, and save a new document in Netscape Composer.  
 
 Type of Learning: Procedural 
 
 IPA 
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1. Open Netscape  Start Menu > Programs > Netscape 
2. Communicator > Composer 
3. Save new document File > Save As 
4. Go to Save in: highlight [C:] 
5. Double click your folder, enter name in File Name field, click Save 
6. Type “Welcome to my web page!” in Page Title field, click OK 

      
Objective 4: The LWBAT place, manipulate, and format text in a Netscape Composer web page.  
 
 Type of Learning: Procedural 
 
 IPA 

1. Click in window and type “Welcome to my World” 
2. Highlight text and choose Format 
3. Select Font and choose new font, do the same with Size, Style, and Color 
4. Highlight “Welcome to my World” and make it a heading  Format > Heading > 

Heading 2 
5. Press enter, type “This is the first Paragraph” 
6. Match your page to example 
7. Click File > Save, or click SaveButton 

 
 
Objective 5: The LWBAT create numbered and bulleted lists in a Netscape Composer web page. 
 
 Type of Learning:  Procedural 
 
 IPA 

1. Place cursor on new line 
2. Choose Format > List > Numbered 
3. Type “This is line 1” click enter, type “This is line 2” click enter 
4. Choose Format > List > Numbered 
5. Repeat steps 2-4 replacing numbered with Bulleted 
6. Compare with sample 
7. Click SaveButton 

 
 
Objective 6: The LWBAT insert horizontal lines in a Netscape Composer web page. 
 
 Type of Learning: Procedural 
 
 IPA 

1. Place mouse at bottom of page 
2. Choose Insert > Horizontal Line 
3. Press Enter, type “Last updated: today’s date” and “Authored by: Your name” 
4. Compare page to example 
5. Click SaveButton 
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Objective 7: The LWBAT define relative and absolute links, and create a link to another web 
page from a Netscape Composer web page. 
 
 Type of Learning: Procedural 
 
 IPA 

1. Place cursor on new line, type “Visit the college of education”, press Enter 
2. Highlight “Visit the college of education” 
3. Choose Insert > Link 
4. In Link to a page location or local file field type http://www.coe.missouri.edu, click 

OK 
5. Compare page to example 
6. Click SaveButton 

 
Objective 8: The LWBAT change the background, text, and link colors of a Netscape Composer 
web page.  
 
 Type of Learning: Procedural 
 
 IPA 

1. Choose Format > Page Colors and Properties 
2. Click the colored rectangle next to Background, choose different colors and view 

them in preview window, set color back to white, click OK 
3. Repeat steps 1 & 2 replacing Background with Normal Text, Link Text, Active 

Link Text, and Followed Link Text 
4. Compare page to sample 
5. Click on SaveButton 

 
Objective 9: The LWBAT list the image file formats that web browsers support,  
download an image from the web and save it to a folder, and insert an image into a Netscape 
Composer web page. 
 
 Type of Learning: Procedural 
 
 IPA 

1. Go to http://www.missouri.edu/images2/logos.html, right click on logo farthest to the 
right, choose Save Image As 

2. In Save As box choose [C:] from Save In drop-down menu 
3. Select your folder and click Open, rename image to “mulogo” and click Save 
4. Place cursor at top of page and press enter. 
5. Choose Insert > Image 
6. Click Choose File Button 
7. Select “mulogo.gif” from your folder and click Open 
8. Click OK 
9. Compare page to sample 
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10. Click on SaveButton 
 
Objective 10:  The LWBAT preview the Netscape Composer web page. 
 
 Type of Learning: Procedural 
 
 IPA 

1. Click Preview Button 
2. Check that Link works properly 
3. Choose Tools > Check Spelling 

 
Objective 11:  The LWBAT identify and apply appropriate web design principles, and identify 
and include appropriate content to include in a teacher web page.  
 
 Type of Learning: Declarative and Procedural 
 
 IPA 

1. Read web sites on choosing the right content for a class web site.  
2. View examples and read web sites on good design principles for use on a class web 

site. 
3. Read web site on copyright and fair use laws. 
4. View examples of class web sites. 
5. Apply knowledge of appropriate content, good design principles, and copyright and 

fair use laws to creating a teacher web page in the final assignment.  
 
Micro-Strategies 
 
1. Terminal Objective: After completing “Unit 7: Introduction to HTML and Netscape 

Composer,” students in the College of Education ED101 class will be able to create web 
pages for their future classrooms that follow good web design principles and provide 
important and appropriate information for their future students. 

 
 
2. Is the overall strategy expository or inquiry? Why? 

The overall strategy is expository because the task is procedural learning.  The best method 
of accomplishing the task will be presented before asking the students to develop their own 
examples.  However, an inquiry-related strategy, specifically an exploratory approach, is also 
used minimally to teach good web design principles and appropriate site content. 
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Instructional Strategy Chart 
Enabling Objective 1: 
LWBAT explain what an HTML document is, describe the minimum requirements of a web page, and explain 
some of the basic HTML tags. 

Introduction Body Conclusion Assessment 
Attention: 
The title of the lesson, 
Lesson 1: An Introduction 
to HTML, will be put into 
a blue gif that draws that 
captures the eye of the 
learner. 

Prior Knowledge: 
The Lesson does not 
directly encourage the 
learner to review particular 
prior knowledge.  It does 
contain an expository 
review of the term Web 
Browser, but it is not safe to 
assume that this is prior 
knowledge to all users.  This 
event is trusted mainly to 
learner-control. 
 

Summarize and Review: 
No summary as this is a 
short lesson. 
 
 

Assess Performance: 
This mainly informational 
lesson will not be assessed 
by itself.  The learners 
understanding of html will 
have an effect on the quality 
of the practice web page 
they create in lesson 2. 
 
 

Purpose: 
The objectives of the 
lesson will be stated in 
bulleted form at the top of 
the page after the text, 
“Upon completion of the 
Lesson you will be able 
to:” 
 

Information & Examples: 
The information about 
HTML and tags will be 
presented in a didactic form.  
It will be presented in text 
form under the heading 
overview. 

Transfer: 
The opportunity for transfer 
will come in the next lesson.  
Learners will have this 
information as relevant prior 
knowledge when learning to 
use Composer. 
 

Feedback/Remediation: 
 

Interest/Motivation: 
The motivation is provided 
in the brief introduction to 
the entire Unit.  The first 
sentence states, “As a 
student in the College of 
Education and as a future 
teacher, it will be 
important that you know 
how to create a web page.” 
 

Attention: 
Hyperlinks, opening and 
closing tags, html, web 
browser and other 
particularly important terms 
will stand out through use of 
boldface and italics.  Once 
again, section headings will 
be put in blue gifs to make 
them grab attention. 
 

Remotivate/Close: 
The lesson will be closed 
when the learner scrolls 
down as far as he/she can 
go.   
 
 

 

Preview:  
The lesson will be 
previewed through 
including the lesson 
objectives as well as 
having the page number 
and contents link at the top 
of the screen.  
 

Learning Strategies: 
Overall strategy: expository 
The presentation of html 
tags will be a deductive 
strategy.  The 
rules/concepts/ procedures 
will be presented before the 
example.  The example 
comes in the form of a 
sample section of code 
followed by a screenshot 
representing the display of 
that code. 
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Instructional Strategy Chart 
Enabling Objective 1: 
LWBAT explain what an HTML document is, describe the minimum requirements of a web page, and explain 
some of the basic HTML tags. 

Introduction Body Conclusion Assessment 
 

 Practice: 
The learners will be told  to 
match components of the 
screenshot with their 
corresponding positions in 
the source code. 
 
 

  

 Feedback: 
The feedback is immediate 
b/c the learner can look at 
the screenshot to find if his  
 

  

 
 
 

Instructional Strategy Chart 
Enabling Objective 2: 
LWBAT create, name, and save an html document containing text, links, lists, colors, horizontal rules, and images 
using Netscape Composer as well as be able to store it in a new folder and preview it in a web browser. 
Introduction Body Conclusion Assessment 
Attention: The title of each 
part will be put into a blue 
gif that draws that captures 
the eye of the learner. 
 

Prior Knowledge: 
The same rhetorical 
questions found in the 
overview section and 
described under the 
Interest/Motivation heading 
also serve as a way to get 
the learner to recall prior 
knowledge.   
 
 

Summarize and Review: 
There is no summary or 
review of each part or of the 
Lesson as a whole. 
 
 

Assess Performance: 
The students personal web 
sites will be evaluated using 
a checklist of all the Lesson 
objectives as well as a rubric 
to judge the work in context 
of design principles 
demonstrated through the 
use of links to good and bad 
examples. See assessment 
description. 
 
 

Purpose:  The objectives of 
each part will be stated in 
bulleted form at the top of 
the page after the text, 
“Upon completion of the 
Lesson you will be able 
to:”  

Information & Examples: 
The information and 
examples are presented in 
an expository manner.  
Graphics are mixed in with 
procedural step descriptions. 

Transfer: 
In Part 10 students are 
assigned to create a personal 
web page or a page to use in 
a future class.  This activity 
promotes tranfer of the new 
skills to real life situations. 

Feedback/Remediation: 
 
See assessment description. 

Interest/Motivation: The 
motivation is provided in 
the brief introduction to the 

Attention: 
As in Lesson 1, the headings 
of each part are displayed in 

Remotivate/Close: 
The last screen will be more 
encouraging and positive in 

 



Jewell, LaVaute 5/7/2002 17   

Instructional Strategy Chart 
Enabling Objective 2: 
LWBAT create, name, and save an html document containing text, links, lists, colors, horizontal rules, and images 
using Netscape Composer as well as be able to store it in a new folder and preview it in a web browser. 
Introduction Body Conclusion Assessment 
entire Unit.  The first 
sentence states, “As a 
student in the College of 
Education and as a future 
teacher, it will be 
important that you know 
how to create a web page.” 
In addition, many of the 
parts will have an 
“Overview section.”  In 
these sections rhetorical 
questions like “As you 
browse the Internet, have 
you ever noticed how large 
some of the web sites that 
you visit are?” will be 
asked.  These questions 
serve to relate the topic to 
real life experiences.   
 

blue gifs to draw the 
learners attention.  In 
addition, the strategy of 
using multiple screenshots 
help attention gaining as 
well.  The screenshots are 
more visually interesting 
that having blocks of text 
merely describing what the 
output of certain steps 
should be. 
 

tone.  The text lets the 
learner know that the Unit is 
complete and attempts to lift 
the excitement level back up 
before the learner moves on 
to another unit. 

Preview: On each of the 
nine screens of this lesson 
the current position within 
the lesson will appear at 
the top as well as a link to 
a table of contents.   
 
 

Learning Strategies: 
Because the task is 
procedural learning, the 
strategy is expository.  Each 
part follows the same basic 
pattern.  The task is broken 
into numbered steps.  The 
step is presented using text, 
followed by a graphical 
representation of that step 
being completed is shown.  
This continues until all the 
steps have been covered.  
This is again a deductive 
strategy because the 
explanations come before 
the examples.   
 

  

 Practice: 
In lesson two, the practice 
should be ongoing.  The 
learners are encouraged to 
actually follow the 
instructions on each screen 
and build a web page as 
they are completing the 
instruction.  By the end of 
Part 9, the learners should 
have a working web page.  
In Part 10, the learners are 
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Instructional Strategy Chart 
Enabling Objective 2: 
LWBAT create, name, and save an html document containing text, links, lists, colors, horizontal rules, and images 
using Netscape Composer as well as be able to store it in a new folder and preview it in a web browser. 
Introduction Body Conclusion Assessment 

assigned to create their own 
web page using the 
procedures they have 
learned. 
 

 Feedback: The feedback 
comes in the form of the 
visual cues included in each 
screen.  The screenshots 
show how the output correct 
completion of the steps 
should produce.  Learners 
can compare this output 
with their own and get 
feedback via their computer 
screen. 
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Media Analysis 
 

Media Analysis Worksheet 
Enabling Objective 1: Upon completion of the lesson, LWBAT describe the 
minimum requirements of a web page, and explain some basic HTML tags. 

Instructional 
Events 

Prescription Final Media 
Choice 

Rationale 

The media choice for the entire instruction set is web-based. 
Attention Attention will be gained by 

showing students examples 
of good and bad web design 
principles, the source code, 
and corresponding page for a 
web page.   

External links It was quicker to 
use external links 
than create 
internal links 
illustrating the 
same concepts. 

Purpose The purpose will be 
conveyed by explaining to 
students why it is important 
to understand how the web 
and HTML code work when 
designing a web site.  

Text.  External 
links to additional 
information may 
be used. 

 

Interest/Motivati
on 

Interest and motivation will 
be tied to purpose.  

  

Preview The only preview students 
will have will be code and 
wysiwyg views of HTML 
code and the corresponding 
web page. 

Text and screen 
shot. 

 

Prior Knowledge Prior knowledge for this unit 
will include having a good 
understanding of basic 
computer use and computing 
terminology.  These skills 
will be developed during the 
previous lessons in the 
ED101 curriculum.  

  

Information & 
Examples 

The information students 
need to complete this lesson 
will be provided through 
textual descriptions, external 
links to examples of web 
pages, or other resource 
pages.   

Text and external 
links 
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Attention Attention will be maintained 
by keeping the material brief 
and relevant.  No other 
attention grabbing elements 
will be used. 

  

Learning 
Strategies 

The information will be 
declarative.  Students will 
not be given the opportunity 
to practice using HTML tags 
in this lesson. 
 
Students will use exploratory 
learning for the introduction 
to good design principles. 

Text 
 
 
 
 
 
External links 

 

Summarize & 
Review 

There will be no official 
summary of this lesson 
because it is very short and 
only serves to provide 
introductory information 
before the Netscape 
Composer lesson. 

  

Transfer The transfer will be done by 
encouraging students to view 
the source code of the web 
pages they create (or other 
external sources) after the 
Netscape Composer lesson to 
see how HTML is being used 
to create the page.   

Text – students 
will use external 
links and own 
work 

 

Remotivate/Clos
e 

Remotivation will be 
accomplished by 
encouraging students to 
pursue learning HTML on 
their own. 

Text, external 
links (both within 
the page and in 
the Resources 
page) 

 

Assess 
Performance 

There will be no assessment 
because this is only 
introductory information that 
is not required in order to 
complete a web page with 
Netscape Composer. 

  

Feedback/Remed
iation 

No feedback, but students 
wanting more information or 
clarification can email the 
instructor. 

Email  
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Media Analysis Worksheet 

Enabling Objective 2: Upon completion of the lesson, LWBAT create a web page 
with appropriate content for a classroom that utilizes good design principles using 
Netscape Composer. 

Instructional 
Events 

Prescription Final Media 
Choice 

Rationale 

The media choice for the entire instruction set is web-based. 
Attention Attention will be gained by 

having students view 
excellent examples of 
teachers’ classroom web 
sites.   

External links  

Purpose The purpose will be 
conveyed by teaching 
students how to create a web 
page in the context as future 
classroom teachers.  This 
will be done by providing 
reasons why having the 
ability to create web pages is 
important as a teacher, 
providing rationale that 
teachers use for creating web 
pages, and providing 
examples of teacher web 
pages. 

External links 
containing 
rationale that 
actual teachers 
used to create 
web page and 
examples of good 
teacher web sites 
will be used. 

 

Interest/Motivati
on 

Interest and motivation will 
be gained by providing 
examples of teacher web 
pages that are in use, as well 
as pages that illustrate 
general principles of good 
and bad design. 

External links It will be easier 
and more 
interesting to 
provide this 
information in 
external links in 
a discovery 
learning method 
rather than 
provide the 
information 
within the text. 

Preview The examples of teacher web 
sites will serve as previews 
of what students should 
strive to create upon 
completion of the unit. 

External links Due to the large 
number of 
teacher sites 
dealing with 
different grades 
or subject areas, 
it would be 
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easier to provide 
a list of external 
links with a 
variety of sites 
than to create 
internal pages 
illustrating only 
a handful of 
principles. 

Prior Knowledge Prior knowledge for this unit 
will include having a good 
understanding of basic 
computer use and computing 
terminology.  These skills 
will be developed during the 
previous lessons in the 
ED101 curriculum.  

  

Information & 
Examples 

The information students 
need to complete this lesson 
will be provided through 
textual descriptions and 
screen shots illustrating 
methods for creating a web 
page.  As students work 
through the unit, they will 
literally be creating a web 
page.  This process will serve 
as a continuous example to 
ensure that the students are 
completing each task 
according to the instructions. 

The entire 
instruction will be 
web-based.  The 
media will 
include text, 
images, and 
external links. 

 

Attention Throughout the instruction, 
links to external web sites 
that provide good examples 
and more information about 
particular areas of interest 
will be embedded in the text.  
Additional information for 
students wishing to go “a 
step further” will also be 
placed at the end of relevant 
sections in the instruction. 

External links and 
in-text additional 
information. 

 

Learning 
Strategies 

The unit will be very 
procedural as it is primarily a 
tutorial, but it is also situated 
within the context to which it 

The instruction 
and discovery 
learning are web-
based. 
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is applied, which is to be 
used to create a classroom 
web site.  It also has an 
element of discovery 
learning in that students will 
be given numerous external 
resources from which they 
form their own opinions 
about the design and 
elements they would like to 
incorporate into a classroom 
web site.  

Summarize & 
Review 

There will be no explicit 
summary; a review will be 
incorporated throughout the 
instruction because students 
will be checking their own 
practice work against the 
screen shots in the 
instruction.  A “this is what 
your web page should look 
like” image will appear at the 
end of each part for students 
to check their work against.  
Students will also be able to 
go back and review lessons if 
they need help on the final 
assignment. 

Text and screen 
shots 

 

Transfer The transfer will be done by 
giving students examples of 
well-designed sites and 
challenging them to learn 
how to create the elements in 
those examples and to search 
for new elements to 
implement. The final 
assignment will also promote 
transfer as students will be 
using their skills to create a 
web page for their own 
hypothetical classrooms. 

External links  

Remotivate/Clos
e 

Remotivation will be 
accomplished by 
encouraging students to find 
more examples of good 
classroom web pages, 

External links  
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challenging them to learn 
how to create the elements in 
those examples, and by 
challenging them to find 
other new and interesting 
elements from other sources 
to incorporate into their web 
pages. 

Assess 
Performance 

Performance will be assessed 
by having students complete 
a final assignment in which 
they will create a classroom 
web site for hypothetical 
class using the skills they 
learned in the unit.  Students’ 
web pages will have to meet 
certain criteria, which will 
include the use of particular 
elements and good design 
principles. 

Computer-based, 
students will 
create a web page 
in Composer on 
their machines. 

 

Feedback/Remed
iation 

Students will receive 
feedback throughout the unit 
as they compare their 
practice work to the 
examples given in the 
instruction.  If their work 
does not match that of the 
image, they will be able to 
review the instruction and 
correct their mistakes.  The 
instructor will also provide 
feedback on the final 
assignments.  Remediation 
will be done by having 
students review specific parts 
they did not comprehend or 
by giving them additional 
resources for more 
information. 

Email  
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C. Assessment Design 
 
Types of Assessment 
 After identifying the objectives for these lessons, the focus of assessment became a 
constant focus. Correlation of the objectives to the design of the tasks, and the assessment tools 
were the main focus throughout this design process. The designing of a pre-assessment survey, 
post-assessment quiz, an attitudinal survey, and a scoring guide for the culminating teacher web 
page assignment were completed to assess learners’ achievement.  Because of previous unit 
content within ED101 addressing the prerequisite knowledge requirements, it was determined 
that a prerequisite skills assessment was not needed. To determine the learners’ level of 
competence in relation to web page development was an initial focus. To identify what learners 
already know about web page creation, a criterion referenced pre-assessment survey was created. 
This on-line, ungraded survey would be administered prior to the students entering into the 
lessons to be completed.  
 During the instruction, students will be able to self-assess their own progress. Through 
the use of numerous screen shots, students will be able to compare their Netscape Composer 
document to the given visual aid.  Through this comparison, students can identify areas in which 
they need to “take a step back” and review the steps they have completed to make their Netscape 
Composer document correlate with the given visual example. This self-assessment will provide 
immediate feedback allowing students to progress through the lesson at an efficient pace.  
 After the instruction is complete, students are provided with a two separate 
postassessment activities. Students will complete a performance-based activity web page 
creation assignment, in addition to a terminology application quiz. These assessments will 
provide feedback to determine if the learner has achieved both the enabling objectives and the 
terminal objective of these lessons. With this information further assistance can be provided, 
sending learners to remedial instruction as necessary.  
 Finally, an assessment of the actual instructional materials will be completed. Learners 
will be asked to complete an attitudinal survey, to determine any problem areas that are 
evidenced as performance problems throughout the provided instruction. With this information, 
further revisions to the current instructional materials may be made. 
 
 
Item Specifications: 
 

The form of the preassessment survey and the postassessment quiz will be a mixture 
Blackboard graded assessment items. Assessment characteristics include multiple-choice, fill-in-
the-blank, and matching, and ordering items. The preassessment survey and postassessment quiz 
are identical with the exception of containing different descriptions, and instructions, because 
these test items have been designed to assess students’ declarative knowledge.  Because of the 
limitations of time, only the most critical subordinate objectives have been included. Objectives 
not addressed in these assessments are addressed in the performance assessment scoring guide, 
as stated below.  It is important to note that this form of assessment has been requested by the 
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COE faculty overseeing the disbursement of this course, because of financially related issues to 
the facilitation.  

The performance assessment activity, “Creating a Web Page With Netscape Composer” 
will be the creation of a web page, graded by a scoring guide. This scoring guide provides the 
evaluator a way to objectively assess the students’ performance, and allows the student to see the 
exact expectations he/she must meet. Each element within the scoring guide directly correlates 
with the stated lesson objectives. In addition to the scoring guide, students are given an 
“Assignment Description” document in which the assignment is brought further into the context 
of the pre-service teacher, and includes an extensive explanation of the components to be 
included in the web page. Upon completion, students’ web pages will then be graded via the 
provided scoring guide. 
 The following objectives are the basis for the creation of the assessment tools:   
 
Terminal Objective:  
After completing “Unit 7: Introduction to HTML and Netscape Composer,” students in the 
College of Education ED101 class will be able to create web pages for their future classrooms 
that follow good web design principles and provide important and appropriate information for 
their future students. 
 
Enabling Objective 1:  
LWBAT explain what an HTML document is, describe the minimum requirements of a web 
page, and explain some of the basic HTML tags. 
 
Enabling Objective 2:  
LWBAT create, name, and save an HTML document containing text, links, lists, colors, 
horizontal rules, and images using Netscape Composer as well as be able to store it in a new 
folder and preview it in a web browser. 

 
Enabling Objective 3:  
LWBAT identify and apply appropriate web design principles, and identify and include 
appropriate content to include in a teacher web page.  

 
The response characteristics of the preassessment and postassessment quizzes differ 

depending on the type of assessment item. Multiple choice, fill-in-the-blank, matching, ordering, 
and multiple answer assessment items will be used in to assess the student’s knowledge. When 
choosing the type of assessment item appropriate to assess knowledge of an objective, the 
designers will review the information and terminology(ies) being addressed, and determine 
where students may have common misconceptions. These common misconceptions will be the 
basis from which the type of assessment item is chosen, and the responses constructed. Example 
preassessment survey and the postassessment quiz assessment items and responses can be found 
below. 

The response characteristics of the postassessment performance-based activity differ 
from that of the preassessment survey and the postassessment quiz, addressed of earlier. The 
characteristics of a correct response to the criteria outlined in the checklist, can vary greatly in 
look, purpose, and placement in the web page. This activity allows the students to demonstrate 
their competence in the above-stated objectives, while expressing their own creativity and 
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adhering to appropriate web design principles and educational content. There is no one right 
answer, except for each learner to include all of the required components of the web page. 
Because of this and the fact that the COE faculty overseeing the disbursement of this course has 
requested a time-efficient assessment tool, this scoring guide has been designed in this format. 
Example scoring guide assessment elements and point values can be found below. 

There are sixteen assessment items for each of the preassessment survey and 
postassessment quiz. These assessment items focus upon declarative knowledge related to web 
page design. The postassessment performance activity scoring guide will include fifteen 
elements which are required in the “Creating a Web Page With Netscape Composer” web page 
assignment. Each element found within the scoring guide is different, and asks the student to not 
only practice the procedural skills taught within the lessons, but also to apply their knowledge 
about web page design principles and content appropriate and applicable to a teacher web page, 
to earn these points. 

The mastery level of the “Netscape Composer” unit is yet to be determined. The 
instructional designers involved in the project cannot make this decision. This decision is to be 
made by the UMC-COE Teacher Development Committee. They are in the process of deciding if 
this course, as a whole, should be a Pass/Fail course, or if it should be assigned a letter grade. 
Mastery level can be determined based on the decision generated by this committee. 
 
Examples of the assessment items included in the preassessment survey and the postassessment quiz: 
 
EX: Matching:  
        Match the link's state with the correct descriptor: 

_____  1. Followed Link A. This is the state of a link that has already been visited. 
       _____  2. Link   B. The normal state of a link before it is clicked. 
 

_____  3. Active Link C. This is the state of a link while it is being clicked. 
 
 
EX: Multiple Choice: 
 
____________________________ is a general term for selectable connection which takes 
viewers to other text, other web sites, files, graphics, music, video, or any other objects that can 
be created and placed in a web page. 

A. highlight  

 B. hyperlink 

C. weblink 
D. target 

 
 
 
 
 
Examples of the assessment items included in the “Creating a Web Page With Netscape Composer” web page 
assignment: 
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EX: Element #5. 
The web page has a numbered OR bulleted list of at least three items. (1) 

 
0 1 

 
EX: Element #14. 
Grade Level and/or Subject Area and/or Specialization are stated in the Web Site index page. (1) 
 

0                1 
 
 
IV. Formative Evaluation Report 
 
A. Description of Field Test 

There were initially three users contacted to participate in the field test.  Unfortunately, 
two of them notified the evaluators on Thursday that they were unable to participate at the field 
test.  User A was still able to participate, and User B agreed to participate at the last minute. 

User A was evaluated Friday, May 3 at 5:00 p.m., and the evaluation lasted one hour and 
45 minutes.  The evaluation took place in 108 Townsend, a large open office area, where she was 
assigned her own computer and desk area at which she could complete the lesson.  The user is a 
freshman College of Education student.  She had no previous experience with HTML or web 
page authoring programs, which placed her in the low range of the target population. 

User B was evaluated on Saturday, May 4 at 6:00 p.m., and the evaluation lasted one 
hour and 15 minutes.  The evaluation took place in 733 Clark in a small computer lab of ten 
computers, in which there were no other people present.  The user was allowed to choose a 
computer to use.  The user is a senior in the College of Education completing his student 
teaching experience.  The user has some experience with Microsoft FrontPage, and feels 
extremely comfortable using computers and learning new applications.  The user’s skills placed 
him in the high range of the target population.   

The evaluation was implemented by first providing an opening and explaining to the 
users about the purpose of ED101 and this unit, the purpose of the evaluation, and how the 
evaluation would proceed (Appendix C.1).  The users first completed a pretest in Blackboard, 
and the answers were recorded.  Feedback, including the correct answers, was provided 
immediately by Blackboard, and users were not allowed to retake the quiz (results in Appendix 
D.3).  Next, as the users progressed through the instruction, the evaluators made observations 
about their progress and any difficulties they encountered on hard copies of the instructional 
materials, and the data was later transferred to a data and interpretation chart (Appendix C.2).  
The users were also encouraged to speak aloud any thoughts they had at any time during the 
instruction, and these comments were recorded as well.  Upon completion of the instruction, the 
users took a posttest in Blackboard, and the answers were recorded.  Feedback, including the 
correct answers, was provided immediately by Blackboard (results in Appendix D.3).  The users 
then completed the final assignment in Netscape Composer, which was assessed with a scoring 
guide (Appendix C.4).  Due to the length of the evaluation, User A was under a time constraint, 
so she was not required to complete all the elements in the final assignment.  She was however 
asked to communicate her ideas verbally.  Both users completed an attitude questionnaire 
(Appendix C.3), and the results were tallied in the questionnaire data summary table (Appendix 
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D.4).  Users were then asked debriefing questions (Appendix C.5) and asked if they had any 
additional comments or questions for the evaluators before being thanked for their time. 

 
B. Results of Field Test 
 Overall, the data collected from the posttests, final assignments, and attitude 
questionnaires revealed that the instruction was very effective.  Both users performed better on 
the posttest as compared to the pretest, but User A’s improvement was much greater than User B.  
Both users were able to complete the requirements sufficiently for the final assignment.  The 
attitude questionnaires also reflected that the users were satisfied with the instruction and their 
performances. 
 The verbal responses informally and from the debriefing questions and attitude 
questionnaire results for both users indicate that the learners believed the instruction to be 
effective.  In particular, both users rated their responses to the following question as either agree 
or strongly agree: 
 

The unit lived up to my expectations. 
The content is relevant to my interests as an education major and as a future teacher. 
The unit activities stimulated my learning. 
I will be able to use what I learned in this course. 
 

User A’s desire to keep her web page relates to her satisfaction with the instruction.  User B felt 
the instruction was too simple.  While he thought the instruction was useful, he was somewhat 
bored with it.  Both users commented that they thought this instruction would be very helpful for 
College of Education students.  User B commented that he wished this instruction was available 
when he was a freshman. 
 All goals and objectives were met sufficiently.  However, while students were able to use 
good design principles and choose appropriate content for the final assignment, the evaluators 
determined that users did not meet Objective 11 to the degree they had hoped.  This is probably 
due to the discovery learning strategy invoked to teach this objective and the subjective nature of 
assessing the skills learned in this objective.   
 Both users indicated during the debriefing questions that they felt they gained more 
knowledge from this instruction.  While User A occasionally had difficulties in the lesson and 
felt the lesson was too long, she felt she learned a lot of useful information.   She seemed pleased 
with her work on the final assignment, as she asked to take it with her.  User B also felt that he 
learned from this lesson.  He felt that he knew a lot of the information presented, but he did feel 
that some of the examples dealing with page design and layout were useful.  He also said that 
seeing examples of teacher web sites gave him some ideas for creating a web site in the future. 
 Through the debriefing questions, it was determined that overall the users enjoyed the 
instruction as well.  User A was frustrated at how long the instruction took, but was glad she was 
able to participate in the evaluation.  She felt she had learned a lot of useful information.  User B 
said he was somewhat bored with the instruction, but he still enjoyed it.  He felt that there was 
enough information that was new to him and good examples in the instruction that he was glad 
he participated. 
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C. Data Tables 
 
The results and revisions of the one-to-one user evaluations are listed in the tables below. 
 
User: User A 
Conducted by: Sarah LaVaute 
Date: May 3, 2002 
When objectives are not referenced, information is being provided about a specific content area 
within the instructional materials that is not related to an objective.   
 

One-to-One Data and Interpretation 
Objective Data Source Information Gained Revision Decision 
 Pretest/Posttest The subject struggled with 

the ordering questions, 
numbers 6 and 15.  She did 
not fully complete either 
question in the pretest.  She 
also indicated that she was 
a “visual learner.” 

These questions may 
be too difficult to 
answer without visual 
aids.  They should 
either be revised or 
removed.  

 “Instructions”  Arrows used clearly note 
the use of navigation tools. 

N/A 

 “Instructions” The graphic which shows 
the exact same navigation 
options, as shown above in 
the page is confusing. 
These are images – not 
able to use for navigation. 

It will be noted that 
the graphic image of 
the navigation choices 
are an example to 
reference for further 
understanding. 

Lesson 
Objective 1 

“Excursion” 
Lesson 1:  
Intro to HTML 

User stated that she liked 
this option for further 
information. 

N/A 

Lesson 
Objective 1 

Lesson 1: Intro to 
HTML 

Examples made sense. 
Subject stated that she is a 
visual learner, so the 
pictures really helped make 
it clear, “how it worked”.  

N/A 

Lesson 
Objective 2 

NC: Part 1 
Preparing to 
Create A Web 
Page 

Subject completed content 
related to this objective 
section with no comments 
and/or problems. 

None 

Lesson 
Objective 11 

“Excursion” 
NC: Part 1 
Preparing to 
Create A Web 
Page 

Subject stated that she 
enjoyed reviewing the 
resources offered about the 
teacher web pages. 

N/A 

 NC: Part 1 
Preparing to 

Subject had problems 
navigating. 

None – this was 
attributed to her 
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Create A Web 
Page 

novice level of tech 
knowledge. 

Lesson 
Objective 3 

NC: Part 2 
Create, Name, 
and Save an 
HTML Document 

Subject had problems 
accessing the “C” drive 
and titling the folder 
correctly. Subject 
attempted to create a folder 
three times, the third time 
was successful.  

None - this was 
attributed to her 
novice level of tech 
knowledge, and the 
fact that she was 
rushing through the 
lesson. Upon slowing 
down the pace, and 
rereading the content, 
the user was 
successful. 

Lesson 
Objective 4 

NC: Part 3 
Adding and 
Formatting Text 

Subject identified a 
discrepancy in the 
appearance of the screen 
shot versus her actual NC 
page document. The text 
size within the screen shot 
was larger than the actual 
NC page, which she was 
creating. The images did 
not look the same, although 
the text settings were the 
same.   

Present screen shots in 
this section, relating to 
the text elements, will 
be removed and 
replaced with screen 
shots which are an 
accurate visual of what 
the user’s page should 
look like. 

Lesson 
Objective 5 

NC: Part 4 
Creating 
Numbered and 
Bulleted Lists  

Subject did not complete 
“Step 3” correctly, by 
spacing as instructed.   

None – Subject had 
not followed 
instructions. Subject 
went back and self-
corrected herself 
successfully after re-
reading the 
instructions. 

Lesson 
Objective 6 

NC: Part 5 
Adding 
Horizontal Lines 
to Your Page 

Subject completed this 
section with no comments 
and/or problems. 

None 

Lesson 
Objective 7 

NC: Part 6 
Adding Links to 
Your Page 

Subject completed this 
section with no comments 
and/or problems. 

None 

Lesson 
Objective 8 

NC: Part 7 
Changing the 
Background, 
Text, and Link 
Colors 

Learner stated everything 
was very clear and easy to 
follow. 

N/A 

Lesson NC: Part 8 Subject skipped through N/A 
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Objective 9 Inserting an 
Image into a Web 
Page 

the first steps, reading each 
step as she went. She then 
went back and completed 
the steps slowly and 
accurately. 

Lesson 
Objective 10 

NC: Part 9 
Previewing Your 
Web Page 

Subject completed this 
section with no comments 
and/or problems. 

None 

Lesson 
Objective 11 

NC: Part 10 
Designing Your 
Own Web Page 

Subject did not look 
through all links because of 
time constraints. Subject 
stated that she liked 
number of resources 
offered and that it was not 
overwhelming. Subject 
stated that the number of 
resources available gave 
students choices that would 
result in a greater variance 
in their final web pages 
design and content choices. 

None – The time 
limitation issue will 
not be a problem 
during regular student 
use. 

Lesson 
Objective 11 

“Creating a Web 
Page” 
Assessment 

Subject completed this 
section with no comments 
and/or problems. 

None 

 
 
User: User B 
Evaluated by: Brice Jewell 
Date: May 4, 2002 
 
When objectives are not referenced, information is being provided about a specific content area 
within the instructional materials that is not related to an objective.   
 

One-to-One Data and Interpretation 
Objective Data Source Information Gained Revision Decision 
 Pretest/Posttest 

 
 
 

Subject said question 6 was 
too complicated.  Subject 
did not complete it in the 
pretest and was clearly 
frustrated with it on the 
posttest. During the 
posttest, he said he could 
complete the task if he was 
using the program, but the 
couldn’t remember the 
names that were used. 

Further testing will be 
needed to determine if 
an adjustment should 
be made.  This 
question may be 
simplified or removed. 
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 Pretest Like question 6 mentioned 
above, the subject said 
question 15 was too 
complicated.   

Further testing is 
needed to determine if 
a change should be 
made.  This user may 
just be impatient. 

 “Instructions” Subject said he frequently 
has to use Mac computers 
in the Reflector. 

Keyboard instructions 
will be added for Mac 
users, but screen shots 
on the Macintosh 
operating system will 
not be added because 
the download time and 
length of each page 
would be greatly 
increased. 

Lesson 
Objective 1 

“Excursion” 
Lesson 1:  
Intro to HTML 

User stated that the 
example of the badly 
designed site was really 
good.  He suggested we 
explain why one is bad and 
why one is good.  

This is simply an 
introductory activity 
designed to gain 
attention.  No further 
explanations will be 
added at this point in 
the instruction. 

Lesson 
Objective 1 

Lesson 1: Intro to 
HTML 

Subject quickly went 
through this section.  He 
spent time comparing the 
image of the web page to 
the HTML code.  He 
skipped the Excursion at 
the bottom of the page. 

None 

Lesson 
Objective 2 

NC: Part 1 
Preparing to 
Create A Web 
Page 

Subject quickly completed 
the tasks in this lesson with 
no difficulty. 

 

Lesson 
Objective 11 

“Excursion” 
NC: Part 2 
Create, Name, 
and Save an 
HTML 
Document. 

Subject read the Excursion, 
but did not follow the 
links.  Subject stated that 
he knew how web pages 
worked. 

Subject seems to be 
skipping and not 
spending much time 
on the Excursion 
sections.  Is there a 
way to encourage the 
students to look at 
them more carefully? 

Lesson 
Objective 3 

NC: Part 2 
Create, Name, 
and Save an 
HTML Document 

Subject noted a typing 
mistake in item 6. 

It should read, “After 
you save the file.” 

Lesson NC: Part 3 After completing this This was a very useful 
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Objective 4 Adding and 
Formatting Text 

section, the user asked the 
evaluator if there were any 
sources that discussed 
appropriate fonts for the 
web.   

comment.  Information 
will be added to 
address this point 
either as text within 
the document or 
through external links. 

Lesson 
Objective 5 

NC: Part 4 
Creating 
Numbered and 
Bulleted Lists  

The subject scrolled to the 
bottom of the page to see 
the final screen shot and 
began trying to create it 
without reading the 
instructions above.  When 
he became confused trying 
to switch from a numbered 
to bulleted list, he returned 
to the top to read the 
instructions.  He 
commented that the screen 
shots were very good and 
helpful in completing the 
lessons. 

None.  This user is 
simply more advanced 
and trying to quickly 
complete the lesson. 

Lesson 
Objective 6 

NC: Part 5 
Adding 
Horizontal Lines 
to Your Page 

Subject completed this 
section with no comments 
and/or problems. 

None 

Lesson 
Objective 7 

NC: Part 6 
Adding Links to 
Your Page 

Subject did not read the 
Excursion section.  Subject 
completed this section with 
no comments and/or 
problems. 

None 

Lesson 
Objective 8 

NC: Part 7 
Changing the 
Background, 
Text, and Link 
Colors 

Subject asked why some 
menu headings and buttons 
are bolded in the 
instructions but Enter in 
“Press Enter” is not. 

The instruction will be 
reviewed and all 
instances of keystrokes 
will be bolded for 
consistency.  If other 
keystrokes and mouse-
clicks are highlighted 
in bold, then changes 
like making “Enter” 
bold should be made 
as well. 

Lesson 
Objective 11 

“Excursion” 
NC: Part 7 
Changing the 
Background, 
Text, and Link 

Subject spent several 
minutes using the color 
picker.  He said that was a 
very useful web site.  He 
also said the examples on 

None 
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Colors background colors were 
useful.  He said he thinks 
there are a lot of people 
that don’t realize how 
important color choices 
are. 

Lesson 
Objective 9 

NC: Part 8 
Inserting an 
Image into a Web 
Page 

Subject completed this 
section with no problems. 

None 

Lesson 
Objective 10 

NC: Part 9 
Previewing Your 
Web Page 

Subject completed this 
section with no comments 
and/or problems. 

None 

Lesson 
Objective 11 

“Excursion” 
NC: Part 9 
Previewing Your 
Web Page 

Subject thought the 
pictures of page layouts 
were very good.  He 
suggested creating a 
picture or template like that 
for a teacher web site. 

None – The aspects of 
this unit that deal with 
web design and 
content are supposed 
to be gained through 
discovery learning.  It 
is hoped that students 
will create their own 
mental picture of what 
a teacher site should 
look like. 

Lesson 
Objective 11 

NC: Part 10 
Designing Your 
Own Web Page 

Subject did read the 
headings in each section 
and some of the 
descriptions, but did not 
look at any sites until he 
got to the teacher web site 
examples.  He said the 
more examples of good 
teacher sites that could be 
provided, the better it 
would be for students. 

None 

Lesson 
Objective 11 

NC: Part 11 
Additional 
Resources 

Subject quickly skimmed 
the list of resources. 
Subject noted that in 
previous links to web sites, 
the pages opened in new 
windows, but the links on 
this page opened within 
Blackboard. 

The source code of 
this page will be 
changed so that all 
links open in new 
windows. 

 NC: Part 12 
Putting Your Site 
Online 

Subject said this 
information was very 
useful and requested a hard 

None 
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copy of it so that he could 
upload his web pages in the 
future. 

Lesson 
Objective 11 

“Creating a Web 
Page” 
Assessment 

Subject used Mrs. Ross’ 
First Grade Class web site 
as an example for the final 
assignment.   He used 
center alignment and 
spaces to create the table of 
contents.  He completed 
the assignment with no 
problems. 

The table of contents 
on Mrs. Ross’ First 
Grade Class web site 
used tables for layout 
purposes.  A unit on 
creating tables in 
Netscape Composer 
should be added to the 
instruction. 

 “After 
instruction” 

After completing the 
instructional materials, the 
subject asked if it would be 
possible to use videos of 
the tasks instead of screen 
shots.   

This option will be 
explored.  Video will 
probably not be used 
entirely, but it could 
be used to supplement 
the instruction.  The 
primary concern with 
using video is the 
length of the download 
time needed to view a 
video clip. 

 
 
 
D. Recommendations for Revisions 

The formative evaluation for this instruction on creating a web page with Netscape 
Composer yielded very valuable information including a few major recommendations for 
revision and several minor recommendations.   The major revisions include inserting new screen 
shots, providing instructions for Macintosh users, and providing scaffolding to encourage 
students to read the “Excursion” sections of the course. 

First, the new screen shots should be added in two parts of the course. The navigation bar 
graphic in the “Instructions” section needs to be modified so that the user can explicitly identify 
that it is a picture. This revision is a result of User A attempting to use the screen shot to navigate 
though the course.   Next, screen shots relating to text elements in “Part 4” of the course should 
be removed and replaced with accurate screen shots that replicate what the user would see as 
he/she completes the required instructions in this section. Presently, the screen shots have correct 
format “settings”  in the screen shot, but appear to be bigger than they are in real life. The 
difference confused User A, and caused her to jump back and forth several times until she 
identified that the format settings were correct in the screen shot, but that the screen shot 
inaccurately depicted how the screen would look during the lesson. 

Second, the additional instructions for Macintosh users will be added. The present 
instruction for this course specifies that users should use PC computers to complete the lesson. 
The designers considered including screen shots for the Macintosh operating system, but 
determined that they would not be added due to the greatly increased download time and length 
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of each page, which would result. To remedy this situation for Macintosh users, they will be 
provided with the correct instructions pertinent to the Macintosh operating system, as the steps of 
the lessons are completed.  For example, while PC users will be given instructions to right-click, 
Macintosh users will be instructed to click and hold. 

Finally, additional scaffolding for students will be added to the present lessons. This 
scaffolding will provide extra “incentive” for students to link to the provided resources in the 
“Excursion” sections. The need for scaffolding was identified when both users skipped many of 
the “Excursion” sections. By skipping these sections, the users were not sufficiently exposed to 
the information pertaining to web page design and content of teacher web pages. The inquiry-
based learning objective was compromised. By stating that these “Excursion” links are required 
reading containing knowledge about which the students will be later held more accountable for 
applying, this problem will be addressed. 

There are several minor revisions to be made to the instructional materials.  In the pretest 
and posttest there are two questions that require students to put six or more specific steps in 
order.  Both users had difficulty with these questions on both the pretest and posttest, which 
indicated to the evaluators that the problem may not be the content of the question, but the 
format instead.  User A also stated that she had difficulty with the questions because she was a 
visual learner.  The steps in the sequences will be combined and broadened in order to make the 
ordering task simpler. 

Some text needs to be revised to make it appear more consistent. The present instruction 
within the pages provides for inconsistent menu headings and buttons, as identified by User B.  
To provide for improved formatting consistency, the instruction will be reviewed and all 
instances of keystrokes will be bolded.  

In “Part 2” of the lesson, one typographical error was found. This will be corrected by 
changing the instruction, from “After you save the picture,” to “After you save the file.” In this 
part of the lesson, students are to actually save a file, not a picture. By removing “picture” and 
replacing it with “file” students will not be confused by the instruction and terminology used. 

An additional minor revision which must be made includes making all links from the 
“Part 11: Additional Resources” open in new windows. Presently this part of the course is the 
only place where “target=’_blank’” is not entered for every link in the code. The source code of 
this page will be changed so that all links open in new windows. 

The last of the minor revisions entails providing further information about web page 
design into the instruction. Because some of the web page examples provided in the instruction 
included the use of tables, students may expect to be able to automatically design a page in this 
format. By creating a unit which offers instruction about creating tables in Netscape Composer, 
students will be able to go further in the instruction, if so desired. Additional information about 
the appropriate use of fonts for web page design will also be added to the instructional materials, 
after User B inquired about further information on this topic and had found none available in the 
“Additional Resources” page.  
 
E. End-of-Project Summary 

From the very beginning, the “Creating a Web Page with Netscape Composer” redesign 
presented unique challenges to the Instructional Design Team.  Going into the project, the team 
members had a clear vision of the revisions that needed to be made to the unit that was founded 
on the results of the initial analysis of the previous version.  The unit was a bland, bare bones 
tutorial in its original form.  It required higher quality media choices to support the procedural 
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learning.  It also needed to be put in a reality-based context. The unit’s intended audience was 
University of Missouri – Columbia’s Freshmen College of Education students, and these learners 
needed not only to be shown how to use Netscape Composer, but also shown design principles 
and content choices that separate effective and well-designed classroom web sites from poor 
planned and ill-structured classroom web sites. With this clear vision in mind, it was the process 
of implementing this vision that presented the most problems. The Design Team through this 
experience learned many lessons.   

While the “Excursion” activities seemed to be a useful way to address this problem in the 
design phase, user testing determined that the students did not use these activities to the extent 
expected.  The greatest problem, and one that was never resolved, was how the Design Team 
could require the students to participate in the “Excursion” activities and then accurately assess 
the knowledge they gained from these inquiry-based learning activities.  
 The Design Team also learned to place greater emphasis on aligning assessment activities 
with the instructional objectives.  After conducting research of other units in the ED101 
curriculum and conducting a needs assessment, it was difficult for the Design Team to redesign 
the “Creating a Web Page” unit based on the objectives, rather than the preexisting structure of 
ED101.  This was a difficult task for the Design Team at first, but they felt that redesigning the 
instruction through the use of the lesson objectives as a framework, they were able to  produce a 
useful and effective set of instructional materials.   

Between the creation of the initial Design Brief and the finished report, a post-assessment 
quiz to assess declarative knowledge and an attitudinal survey were added to the list of 
assessment items. Additionally, a pre-assessment survey and a final web page assignment 
description and scoring guide were designed and included in the final learning unit. The Design 
Team felt the addition of these elements contributed to the overall success of the instruction and 
the formative evaluation. These additions provided for a better measurement of student aptitude 
both before and after completing this unit.  

While the one-to-one user testing yielded important information, the Design Team 
concluded that more evaluation methods need to be employed to effectively address the 
identified revisions in the instruction.  If this evaluation were to continue, a focus group 
interview would be a very helpful instrument to use.  Ideally, a pilot test conducted with a group 
of students who will actually be given a grade in a regular course for their work in this 
instruction would be the perfect environment to conduct an evaluation. 
 Finally, the Team learned a valuable lesson about the execution of formative reviews.  
Given the chance to do the project over, the user reviews would be scheduled farther from the 
project deadline.  The Team did not leave enough time to account for cancellations by subjects, 
which became a problem.  Scheduling the sessions further in advance as well as additional 
follow up contacts with subjects to strengthen their commitment could help avoid this problem in 
the future. 
 
V. Instructional Products 
 

The instructional materials used for the “Creating a Web Page with Netscape Composer” 
unit can be found in the University of Missouri’s College of Education Blackboard web site at 
http://courseinfo.coe.missouri.edu.  Use the username “guest1” and the password “1234” 
(without quotes) to enter the site.  Once logged in, click the link under “Courses” labeled 
“Technology Skills for Teacher Education Students.”  Next, click the “Course Documents” 
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button.  The “Creating a Web Page” unit is labeled “Netscape Composer Revised” until final 
revisions are made and the unit is ready for use.  Click the link above to view the instructional 
materials. 
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A.1 OBSERVATION LOG 
 
Unit: 
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A.2 EXPERT EVALUATION OPENING 
 

Note: The Subject Matter Expert for this formative evaluation, Dr. Jane Howland, is the 
administrator overseeing the instructional designer assigned to the ED101 project. She has 
worked with the ED101 project for over a year. Because of this fact, the following opening 
statement addresses the formative evaluation focus and the reasoning behind this process being 
conducted. 
 
Statement: 
 Thanks again, Dr. Howland, for agreeing to help us evaluate this instruction.  As you 
know, this unit will be part of the ED101 course curriculum.  The “Creating a Web Page” unit 
we will be looking at today focuses on both the HTML lesson, and the Netscape Composer 
lesson.  We estimate that this evaluation process should take about an hour and a half to 
complete.  
 

As we have discussed, this Netscape Composer unit is still being developed.  We really 
need your help to make these materials as good as possible.  You can help us the most by telling 
us exactly what you think of the materials.  If you think it is boring, too easy, too difficult, very 
helpful, or anything else, we would really appreciate your input.  We believe that your expertise 
in the areas of web development, teaching on-line courses, and developing on-line instructional 
materials will be invaluable to the development of this unit and can assist us in the revision of the 
other units within ED101.  

 
It would also greatly help us if you could speak aloud as you go through the lesson.  Just 

say what you are thinking as you go through, and feel free to ask questions or make suggestions 
at any time.  This will really help us because we have looked at this so many times that it is hard 
for us to guess what it would be like to use it for the first time.  So by speaking aloud as you 
work, you will be giving us a lot of information about what it is like to do the lesson. 
 

As you know, ED101 is offered through the COE Blackboard 5 platform. Please access 
this to follow the tutorial.  You will begin the unit by reading a set of instructions about 
navigating through the lesson on Blackboard.  You will then read a basic introduction to web 
pages and HTML.  Next, you will begin working through the Netscape Composer tutorial and 
learn how to make a web page.  After it is all finished, we would really appreciate it if you would 
fill out a brief questionnaire about the unit, and then address any specific questions that we have 
not covered elsewhere. That’s it!  Do you have any questions for us before we begin? 
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A.3 EXPERT EVALUATION QUESTIONNAIRE 
 
 
REVIEWER: __________________________       DATE: _________________________ 
 
 
Please circle your rating and write comments on each aspect of the ED101 Netscape Composer 
Unit.  1 represents the lowest and most negative impression on the scale, 3 represents an 
adequate impression, and 5 represents the highest and most positive impression.  Choose N/A if 
the item is not appropriate or not applicable to this course.  Use the space provided after each 
item for further comments. If more room is needed  
 
NA=Not applicable    1=Strongly disagree    2=Disagree    3=Neither agree/nor disagree    4=Agree    5=Strongly agree 
 
AREA 1 - INSTRUCTIONAL DESIGN REVIEW 
 
 
1. The information in the unit is accurate. N/A     1     2     3     4     5 
Comments: 
 
 
 
 
2. The information in the unit is current. N/A     1     2     3     4     5 
Comments: 
 
 
 
 
3. The information in this unit is sufficient in scope. N/A     1     2     3     4     5 
Comments: 
 
 
 
 
4. Information in this unit is provided in a precise  N/A     1     2     3     4     5 
and orderly fashion. 
Comments: 
 
 
 
 
5.  This unit provides learners with a  N/A     1     2     3     4     5 
clear knowledge of the unit objectives.  
Comments: 
 
6.  The instructional interactions in this unit  N/A     1     2     3     4     5 
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are appropriate for the unit objectives. 
Comments: 
 
 
 
 
7.  The instructional design of this unit is N/A     1     2     3     4     5 
based on sound learning theory and principles.  
Comments: 
 
 
 
 
8. Instructions given throughout the unit are clear. N/A   1     2     3     4     5 
Comments: 
 
 
 
 
9.  The feedback in this unit is clear.   N/A     1     2     3     4     5 
Comments: 
 
 
 
 
10.  The pace of this unit is appropriate. N/A     1     2     3     4     5 
Comments: 
 
 
 
 
 
11. The difficulty level of this unit is appropriate.   N/A     1     2     3     4     5 
Comments: 
 
 
 
 
 
12. All objectives in this unit are weighted appropriately N/A     1     2     3     4     5 
throughout the unit. 
Comments: 
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13. The activities in this unit gave the user sufficient   N/A   1     2     3     4     5 
practice and feedback. 
Comments: 
 
 
 
 
14. The content is relevant to the users’ present role as N/A   1     2     3     4     5 
a College of Education pre-service teacher and as a  
future professional teacher.   
Comments: 
 
 
 
15. The content is related to the context in which the  N/A   1     2     3     4     5 
student will apply these skills (student, future teacher).  
Comments: 
 
 
 
 
16. The unit provides for interactivity, and is  N/A   1     2     3     4     5 
not formatted in solely  procedural instruction. 
Comments: 
  
 
 
17. Remedial resources offered are of significant  N/A   1     2     3     4     5 
quality (current, accurate, designed well) and service  
the needs of various learning styles and needs.   
Comments: 
 
 
 
 
AREA 2 - COSMETIC DESIGN REVIEW 
 
18.  The screen design of this unit follows sound principles. N/A     1     2     3     4     5 
Comments: 
 
 
 
 
19.  Color is used appropriately within the unit. N/A     1     2     3     4     5 
Comments: 
20.  The screen displays are easy to understand. N/A     1     2     3     4     5 
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Comments: 
 
 
 
 
 
21. The use of images is appropriate throughout  N/A   1     2     3     4     5 
the unit.  
Comments: 
 
 
 
 
 
22. This unit is accessible by most users. N/A   1     2     3     4     5 
Comments: 
 
 
 
 
AREA 3 - PROGRAM FUNCTIONALITY REVIEW 
 
23.  This unit’s navigation operates flawlessly. N/A     1     2     3     4     5 
Comments: 
 
 
 
 
 
 
AREA 4 – OVERALL UNIT REVIEW 
 
24. How would you improve this unit?   (Check all that apply.) 
___Provide better information before unit. ___Clarify the unit objectives. 
___Reduce content covered in unit. ___Increase content covered in unit. 
___Update content covered in unit. ___Improve the instructional methods. 
___Make unit activities more stimulating. ___Improve unit organization. 
___Make the unit less difficult. ___Make the unit more difficult. 
___Slow down the pace of the unit. ___Speed up the pace of the unit. 
___Allot more time for the unit. ___Shorten the time for the unit. 
___Improve the assessments used in the unit. ___Add multimedia elements such as video 

to the unit. 
Comments: 
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A.4 EXPERT EVALUATION DEBRIEFING QUESTIONS 
 
1.  Do you think there should be a resources page with links to external sites? 
 
 
2.  Do you think instruction should be given on how to create zip files and on how to upload web 
pages? 
 
 
3.  Are there any parts of the units or of the instruction that need to be better explained or 
clarified? 
 
 
5.  Do you think the instruction sufficiently covers the skills pre-service COE teachers need to 
have to successfully create a web page? 
 
 
6.  What is least valuable about this unit? 
 
 
7.  What is most valuable about this unit? 
 
 
8. What other improvements would you recommend in this course? 
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A.5 USER EVALUATION OPENING 
 

Thanks again _____ for agreeing to help us evaluate this instruction.  This unit will be 
part of a course called ED101 that will be offered to freshmen COE pre-service teachers.  ED101 
will be offered completely online.  The main goal of this course is to teach pre-service UMC-
COE students basic computing skills.  Some of the skills covered in the course will be 
performing Internet searches, sending email, using Word, using Excel, using PowerPoint, and 
creating a web page with Netscape Composer.  As you know, the unit we will be looking at 
today is on creating a web page.  The lesson should take about an hour to complete.  
 

This Netscape Composer unit is still being developed.  We really need your help to make 
these materials as good as possible.  You can help us the most by telling us exactly what you 
think of the materials.  If you think it is boring, too easy, too difficult, very helpful, or anything 
else, we would really like you to tell us.  You aren’t being graded on how well you do in this 
exercise and we won’t be upset if you don’t like something, so you don’t have to worry about 
anything.  Please just work through the lesson and complete the exercises as best you can.  It 
would also really help us if you could speak aloud as you go through the lesson.  Just say what 
you are thinking as you go through, and feel free to ask questions or make suggestions at any 
time.  This will really help us because we have looked at this so many times that it is hard for us 
to guess what it would be like to use it for the first time.  So by speaking aloud as you work, you 
will be giving us a lot of information about what it is like to do the lesson. 
 

Because ED101 will be online, you will use Blackboard to follow this tutorial.  You will 
begin the unit by reading a set of instructions about navigating through the lesson on Blackboard.  
You will then read a basic introduction to web pages and HTML.  Next, you will begin working 
through the Netscape Composer tutorial and learn how to make a web page.  After the tutorial, 
we would like you to create a simple web page of your own following a few guidelines.  After it 
is all finished, we would like you to fill out a brief questionnaire about the unit.  That’s it!  Do 
you have any questions for me before we begin? 
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A.6 USER EVALUATION QUESTIONNAIRE  
 
 
Unit Name: ________________________   Training Location: _______________________ 
  
Participant Name (optional): ________________________________  Date: _______________                          
 
Year in school:   Fresh     Soph     Jr     Sr     
 
INSTRUCTIONS: 
Please circle your response to the items.  Rate aspects of the course on a 1 to 5 scale, where 1 
equals "strongly disagree" and 5 equals "strongly agree."  The number 1 represents the lowest 
and most negative impression on the scale, 3 represents an adequate impression, and 5 represents 
the highest and most positive impression.  Choose N/A if the item is not appropriate or not 
applicable to this course.  Your feedback is sincerely appreciated.  Thank you.   
 
A. UNIT CONTENT:   (Circle your response to each item.) 
NA=Not applicable  1=Strongly disagree  2=Disagree  3=Neither agree/nor disagree  4=Agree   5=Strongly agree 
 
1. I was informed about the overall goal of this unit.     N/A   1     2     3     4     5 
Comments: 
 
2. I was well informed about the specific objectives   N/A   1     2     3     4     5 
 of this unit. 
Comments: 
 
3. The language of instructional materials within this N/A   1     2     3     4     5 
 unit is clear and easy to understand. 
Comments: 
 
4. This unit lived up to my expectations.   N/A   1     2     3     4     5 
Comments: 
 
5. The content is relevant to my interests as an education  N/A   1     2     3     4     5 
 major and as a future teacher.  
Comments:   
 
 
 
B. UNIT DESIGN:   (Circle your response to each item.) 
 
6. The instructions on how to use the unit are clear to me.  N/A   1     2     3     4     5 
Comments: 
 
7. The unit objectives are clear to me.   N/A   1     2     3     4     5   
Comments: 
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8. The unit activities stimulated my learning.   N/A   1     2     3     4     5 
Comments: 
  
9. The use of images is essential in the unit. N/A   1     2     3     4     5 
Comments: 
 
10. The activities in this unit gave me sufficient   N/A   1     2     3     4     5 
 practice and feedback. 
Comments: 
 
11. The final assignment in this unit is fair.   N/A   1     2     3     4     5 
Comments: 
 
12. The difficulty level of this unit is appropriate.   N/A   1     2     3     4     5 
Comments: 
 
13. The individual lessons in this unit follow a logical  N/A   1     2     3     4     5 
 sequence. 
Comments: 
  
14. The length of this unit is appropriate.   N/A   1     2     3     4     5 
Comments: 
 
 
C. SELF-PACED DELIVERY:  (Circle your response to each item.) 
 
15. This self-paced tutorial is a good way for me to learn this  N/A   1     2     3     4     5 

content. 
Comments: 
  
 
NA=Not applicable  1=Strongly disagree  2=Disagree  3=Neither agree/nor disagree  4=Agree   5=Strongly agree 
 
D. UNIT RESULTS:   (Circle your response to each item.) 
 
16. I accomplished the objectives of this course.    N/A   1     2     3     4     5 
Comments: 
  
17. I will be able to use what I learned in this course. N/A   1     2     3     4     5 
Comments:  
 
   
18. How would you improve this course?   (Check all that apply.) 
___Provide better information before course. ___Clarify the course objectives. 
___Reduce content covered in course. ___Increase content covered in course. 
___Update content covered in course. ___Improve the practice items in the course. 
___Make course activities more stimulating. ___Improve course organization. 
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___Make the course less difficult. ___Shorten the length of the course. 
___Make the course more difficult. ___Add more images to the course. 
___Improve the final assignment in the course.  
 
Comments: 
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A.7 USER EVALUATION DEBRIEFING QUESTIONS 
 
1.  Did you enjoy the unit? 
 
 
2.  Do you think you have the ability to create a web page on your own after this unit? 
 
 
3.  Do you think being able to create a web page is an important skill for freshmen COE students 
to have? 
 
 
4.  Are there any parts of the units or of the instruction that need to be better explained or 
clarified? 
 
 
5.  What is least valuable about this unit? 
 
 
6.  What is most valuable about this unit? 
 
 
7. What other improvements would you recommend in this course? 
 
 



Jewell, LaVaute 5/7/2002 54   

A.8 CREATING A WEB PAGE WITH NETSCAPE COMPOSER 
FINAL ASSIGNEMNT RUBRIC 

 
For each element, mark whether it is present or not. 
Element Yes No 
1. The web page has a title.   
2. There is at least one heading in the web page.   
3. There is one example of bold text.   
4. There is one example of italicized text.   
5. The web page has a list of at least three items.   
6.  There is a horizontal line at the bottom of the page followed by 
“Authored by” and your name. 

  

7. There are two links to other web sites.   
8. The background color is not white OR there is an image for the 
background. 

  

9. The “Link”, “Active Link”, and “Followed Link” colors are three 
different colors 

  

10. There is one image on the web page.   
11. All of the files for the web page are stored in a folder with the 
user’s name on the C drive. 

  

 
The user successfully completed ___/11 of the requirements for the final web page. 
  
 



Appendix B – Needs Assessment Analysis Data 
 

Appendix B contains all of the data gathered during the needs assessment analysis. 
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B.1 OBSERVATION LOG - EXPERT EVALUATION 

 
Unit: Creating a Web Page 
Reviewer: Dr. Jane Howland 
Date: 2/28/02 
Reviewed by: Sarah LaVaute and Brice Jewell 
 
SCREEN           COMMENTS & SUGGESTIONS             ACTIONS TAKEN 
Before Intro Spend some time explaining what a web site is.  Talk about 

what the Internet is, how files get on the web, include a  
diagram of how web sites and the Internet work, and how  
search engines work.   
 
Briefly talk about file sizes and load times - small and large 
files and fast and slow connections and how they relate to  
load times. 
 
Give some examples of slow/fast loading pages and good  
and bad web design. 

A second part should be added to the 
first lesson along with the discussion of 
HTML.  This new section could 
address what a web site is, how the 
Internet works, search engines, etc. 
 
Load times should also be mentioned.  
This will probably best be illustrated 
by creating some slow and fast loading 
pages to use as examples.  Examples of 
good and bad web design might also be 
created. 

Lesson 1: 
Intro to 
HTML 

In the HEAD tag description, change 2nd sentence to say it 
"contains the title tag" rather than "displays to the viewer."  
Also include other tags, such as meta keywords and  
description - relate to how search engines work. 
 
In the HREF tag, the wording about the link that leads to  
another page is misleading.  Rewrite and consider including
a full example of an HREF tag. 
 
Really likes the HTML code example of a web page and  
then the screen shot of the same page. 

The HEAD tag description will be 
corrected. 
 
 
 
The HREF tag example will be created 
and the wording will be changed so 
that it is more understandable. 

Lesson 2, 
Part 1 

Good explanation of the file structure.    The "manila folder" 
analogy really helps put the technical info into a real world  
example that the users should be able to understand. 

 

Lesson 2, 
Part 2 

Need more white space between the image/text/image  
sequence.  Either place more line breaks in between,  
increase the font size or both. 
 
 
In the Save HTML file sequence, make sure that the student
sees the .html extension on the end of the file.  It is really  
important that they understand that a web file must have  
that extension.  

Her screen resolution was set really 
high.  It was probably 1600x1200, and 
the page did look cramped, but it looks 
fine at 800x600 or 1024x768. 
 
The student will not see the .html 
extension because HTML Files is 
listed in the Save as type box below the 
file name.  If the student included the 
.html extension, the file would be 
smith.html.html. 

Lesson 2, 
Part 3 

Dr. Howland was asked about two different procedures for  
inserting elements: using the Composer menus or using the 
toolbar shortcut buttons.  She thought that both formats  
should continue to be included in the instruction because  
some users may prefer to use one way and some the other  
way.  She doesn't think it is confusing or too cluttered. 

The instruction will remain as is; both 
procedures will be included. 

Lesson 2, 
Part 4 

The screen shots aver very good and easy to understand.   
They do a nice job of illustrating the procedure step by step.

 

Lesson 2, 
Part 5 

No comments.  
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Lesson 2, 
Part 6 

In defining relative links, use the wording "to link to pages  
in a folder within your site."  In the last sentence of the  
second paragraph, the student would  need to know that  
he/she would have to actually name the file page2.html. 
 
When adding a link in the Character Properties illustration  
and then choosing to link to another file within the site, is  
the full path to the file displayed in the window?  It is  
important that the user understand the file/path structure to  
other files. 

The wording suggested for the relative 
link will be used.  No other changes 
will be made.  The other suggestions 
aren’t necessary for this basic 
introduction. 

Lesson 2, 
Part 7 

In the last paragraph in the overview that talks about bad  
web design, it would be useful to link out to examples of  
good and bad design.  It may be a good idea to include a  
little more information about bad web design in this  
paragraph too. 
 
In the note about adding pictures as background images, it  
is okay to insert pictures as long as they are appropriate to  
be used for backgrounds.  Provide information about  
contrast. 
 
Dr. Howland was asked about the format of creating Notes  
sections in italics that provide additional information  
beyond the specific objectives for that section.  Question  
posed: Is the format a good way to present this?  The format
 is fine as long as it is consistently presented this way  
throughout the unit and as long as italics are not used for 
other pieces of information that are not "a step further" type
of information. 

Examples of good and bad web design 
will be included in the external links 
section of Blackboard.  Some of those 
sites will also be included in this 
section. 
 
More information will be provided for 
users wanting to use images as 
background. 
 
Additional lessons that are more 
advanced may be created at the end 
rather than using Notes sections if 
there is enough content to justify it. 

Lesson 2, 
Part 8 

Consider a better definition for GIF files.  Perhaps mention 
that GIF files are usually use for images with a few colors or
block of colors.   
 
Typo on the JPG description in the second sentence. 
 
Consider including examples of images of the three  
different types. 
 
In the section on downloading an image from the web,  
explain how to do this on a Macintosh.  Procedures for Mac
users  need to be included throughout the unit, not just  
this part. The Mac instructions could be included in  
parentheses behind the PC instructions. 
 
The link to the last image in the unit is broken. 

The GIF definition will not change. 
 
 
 
The typo will be corrected. 
 
Examples of the image types will be 
included. 
 
Incorporating Mac user instructions 
throughout the entire unit should be 
considered. 
 
 
 
The image link will be fixed. 

Lesson 2, 
Part 9 

Great section.  

Final 
Assignment 

In the criterion for including a list, specify how many items 
need to be in the list. 
 
In the criterion for changing the background, be careful not 
to encourage bad web design.  Consider providing more  
guidance in this criterion. 
 
The assessment tool of this final assignment should be a  
simple rubric.  It should be a yes/no checklist; either the  
page has the requirement or it doesn't. 

The number of items for the list will be 
added. 
 
The rubric developed is a yes/no 
checklist. 
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General 
Comments 

The navigation buttons in Blackboard disappear when the  
learning module for the Netscape Composer unit is started. 
One can still navigate through the lesson still, but the  
Blackboard buttons disappear.  Consider a different  
structure for the unit.  Talk to the Blackboard System  
Administrator to learn about the file structure of  
Blackboard. (Presently using Netscape Navigator 4.7on  
a Mac.) 
 
Teach users how to FTP to their Bengal web space.  This is 
a skill they will need to know whether they upload their  
pages here at MU or later in life to another server.  Teach  
both a PC program like WS_FTP and a Mac program like  
Fetch. 
 
Consider creating a section for going "a step further." This  
would allow for more advanced users to continue to  
broaden their knowledge past the basics of this lesson. 
 
Create a resources page with external links to example of  
good and bad web design, examples of good teacher web  
sites, and other resources for learning more about creating  
web pages.  This will cater to those users that are looking to
learn more information. 

This was originally believed to be a 
Netscape problem, but Netscape 4.7 on 
the PC displays the unit correctly.  It is 
now believed that the problem is with 
the Mac platform somehow. 
 
 
 
 
A part describing the FTP process will 
be added, but probably at the end.  This 
may be part of the more advanced 
lessons being considered. 
 
 
The step further section has already 
been addressed. 
 
 
The external links page has already 
been addressed. 
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B.2 EXPERT QUESTIONNAIRE DATA SUMMARY 
 

 
The expert was asked to respond to each statement using the following scale: 
NA=Not applicable  1=Strongly disagree  2=Disagree  3=Neither agree/nor disagree  4=Agree   5=Strongly 
agree 
 
Questions Expert 
1.  The information in the unit is accurate. 3 
2.  The information in the unit is current. 5 
3.  The information in this unit is sufficient in scope. 4 
4.  Information in this unit is provided in a precise and orderly fashion. 5 
5.  This unit provides learners with a clear knowledge of the unit 
objectives. 

5 

6.  The instructional interactions in this unit are appropriate for the unit 
objectives. 

5 

7.  The instructional design of this unit is based on sound learning theory 
and principles. 

5 

8.  Instructions given throughout the unit are clear. 4 
9.  The feedback in this unit is clear. N/A 
10.  The pace of this unit is appropriate. N/A 
11.  The difficulty level of this unit is appropriate. 5 
12.  All objectives in this unit are weighted appropriately throughout the 
unit. 

N/A 

13.  The activities in this unit gave the user sufficient practice and 
feedback. 

4 

14.  The content is relevant to the users’ present role as a College of 
Education pre-service teacher and as a future professional teacher. 

5 

15.  The content is related to the context in which the student will apply 
these skills (student, future teacher). 

4 

16.  The unit provides for interactivity, and is not formatted in solely 
procedural instruction. 

5 

17.  Remedial resources offered are of significant quality (current, 
accurate, designed well) and service the needs of various learning styles 
and needs. 

2 

18.  The screen design of this unit follows sound principles. 3 
19.  Color is used appropriately within the unit. 5 
20.  The screen displays are easy to understand. 5 
21.  The use of images is appropriate throughout the unit. 5 
22.  This unit is accessible by most users. 4 
23.  This unit’s navigation operates flawlessly. 2 
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B.3 OBSERVATION LOG - USER A 
 
Unit: Creating a Web Page with Netscape Composer 
Reviewer: User A 
Date: 3/4/02 
Reviewed by: Brice Jewell 
 
SCREEN           COMMENTS & SUGGESTIONS             ACTIONS TAKEN 
Instructions These were pretty self-explanatory (she has a lot of  

experience with Blackboard).  Clicked the back arrow to  
return to main menu. 

 

Lesson 1: 
Intro to 
HTML 

What are tags?  Tags are mentioned before they are really  
explained.  Might be talking about them too early. 
 
She skipped over the HTML code example page and went  
straight on to the descriptions.  She was confused about the 
descriptions and suggested that the HTML code under the  
“See for Yourself” section be placed higher.  It is, but she  
didn’t notice it. 
 
Tag descriptions are good. 
 
She used the back arrow to return to the main menu. 

The user was advised to keep reading, 
and she figured it out. 
 
Nothing will be changed. 

Lesson 2, 
Part 1 

Went back and forth between the desktop and the tutorial  
during the creating the folder section.  She read one line  
then went to the desktop and went back and forth. 
 
Lost the first new folder because she clicked off of it when  
trying to rename it because she was going back and forth to 
the tutorial.  She created a second folder. 

There is no easy solution to the 
problem of going back and forth.   

Lesson 2, 
Part 2 

She opened a new Navigator window in order to launch  
Composer. 
 
Liked the first screen shot.  Said it was good for people not 
familiar with how programs work. 
 
She did this unit perfectly, but made the comment that it  
was a little hard going back and forth between Composer  
and the tutorial.  

 

Lesson 2, 
Part 3 

She read through all of the steps about formatting text first. 
She didn’t practice changing any of the settings.  She just  
did the final step of each one.  She says this section is too  
basic for people that have experience with Word, which is  
why she didn’t practice.  She says she has been, “…doing  
this forever in Word.” 
 
She liked the Note section.  She was about to ask the  
question that is answered by the section because she was  
having difficulty changing the settings back. 
 
Really liked the screenshots because they helped her  
double-check to make sure she was in the right spot. 

The section on formatting text will not 
be changed or removed.  It is important 
to keep this section in for users that are 
not as skilled. 
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Lesson 2, 
Part 4 

She did the actions here 1 step at a time rather than reading 
ahead and doing more than one at a time.    She checked her 
work against the screen shots. 
 
The use of the list shortcut buttons was good.  
 
She scrolled to look at the picture for step 4 under bulleted  
list before starting to type. 
 
She used the menu method for creating the numbered list  
and the button for creating the bulleted list.  She did this  
whole lesson without any hesitation. 

 

Lesson 2, 
Part 5 

In Step 1, she asked if the bottom of the page is where the  
Cursor currently is. 

A small note will be added that the line 
is supposed to go where the cursor is. 

Lesson 2, 
Part 6 

Suggested that hyperlinks also be described as the blue  
underlined words in a web page. 
 
Thought the descriptions of absolute and relative were very 
clear. 
 
For the Visit the College of Education link, she didn’t  
include the http in the URL, so the link didn’t work. 
 
She has started using the shortcut buttons to add elements  
rather than the menus. 

It will be mentioned that hyperlinks are 
generally blue, underlined words on a 
web page. 
 
Nothing else will be changed. 

Lesson 2, 
Part 7 

Thought the link descriptions were good.  Using the colors  
in the descriptions helps the user relate to what they are  
used to seeing in a web page. 
 
The Page Colors and Properties menu didn’t open to the  
Colors and Backgrounds tab so she was confused.  She said 
she would have noticed if she had looked more closely. 
 
The Active link color was red on the computer she used,  
but it is blue in the screen shot. 

The instructions will be revised to 
instruct users on how to get to the Page 
Colors and Properties tab if it doesn’t 
open automatically. 
 
The screen shot of the link colors will 
also be changed so that the active link 
color is red.  This seems to be the most 
common default color. 

Lesson 2, 
Part 8 

Good explanation of digitizing, and said the scanner  
example was really important. 
 
On the image formats, she asked which format to use.  Said 
it would be helpful if there were specific situations like use 
.jpg for photos.    
 
Said explaining how to save images in IE was good to 
 include. 
 
She went back and forth with the save as box open between 
steps during the save image process.   
 
She suggested that in the instruction it tell the user to make 
sure the image was a GIF. 
 
When choosing the image to open, she checked the files of  
type pull-down menu. 
 
When trying to move on to the next section, she clicked the 
contents button instead of the arrow by accident. 

 
 
 
No hard and fast rules can really be 
offered on which format to use.  
However, another example will be 
given to help users understand the 
differences better.  Images will also be 
added. 
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Lesson 2, 
Part 9 

She forgot to save the file from the last part, so she had to  
save the file before previewing it. 
 
The link didn’t work because she forgot to add the http to  
the URL from part 6. 
 
When she checked spelling, “bulleted” came up misspelled, 
but she ignored it. 

 
 
 
 
 
 
While Composer finds this word 
misspelled, MS Word spells it with 
only one “t”.  This is not a significant 
problem. 

Final 
Assignment 

She completed all 11 criteria on the final assignment rubric 
correctly. 
 
When she read the criterion about the background color with
 the option of using an image, she thought that was asking  
to insert an image in the page in addition to the background 
color. 
 
She used the MU logo page for her image.  She didn’t need 
to reread any directions, but she had to go back to find the  
URL for the images page. 
 
She had difficulty on the link properties window because  
instead of highlighting text first to turn into a link, she just  
clicked the link button to create the link.  She was typing the
 URL in the top field, which is where the linked text is  
supposed to be. 

 

Debriefing 
Questions 

 Tips for searching for clip art on the 
Internet will be included or direct links 
will be provided in the part on 
inserting images. 
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B.4 OBSERVATION LOG – USER B 

 
Unit: Creating a Web Page with Netscape Composer 
Reviewer: User B 
Date: 3/4/02 
Reviewed by: Sarah LaVaute 
 
SCREEN           COMMENTS & SUGGESTIONS             ACTIONS TAKEN 
Lesson 1: 
Intro to 
HTML 

User wanted clarification and more explanation given  
about the difference between, and use of opening and  
closing tags.  
 
User stated that a screenshot detailing the Head vs. Title  
Tags would be helpful, embedded in the text about these  
two tags.  
 
The user requested a verbal explanation about the HREF tag 
information. After a verbal explanation, he understood the  
text. He then suggested that an more thorough example be 
used.  

The HREF tag paragraph will be better 
explained. 

Lesson 2, 
Part 2 

User stated that he liked the objectives being stated at the  
beginning of each mini-lesson within the lessons. He stated 
 that it helped orientate him to the overall goal of the lesson.
 
Asked if it was necessary to explain and illustrate how to  
save the file.  

 

Lesson 2, 
Part 3 

Need to choose a more specific color that “medium shade 
of green” in the instructions for changing the color of the  
text. 
 
Suggested that in the directions for adding elements that the
toolbar button method be explained first because it is easier.
 
Before step 4, and after the heading size, suggested the  
directions read “After setting your heading size, de-select 
 the text. Then press the Enter key once.”  

The toolbar shortcut button will be  
mentioned first in the directions. 
 
 
 
 
 
The “de-selection of text” instructions 
will be included. 

Lesson 2, 
Part 4 

Again suggested that the toolbar shortcut method be  
explained first in the directions before the menu method. 
 
Made a positive comment about the screen shots matching  
the user’s practice page. He stated that this was a key  
characteristic of quality, stressed to students involved in  
a class he had previously taken, in which the students were 
required to take an on-line tutorial.  
 
In step 5, in which the user is supposed to create  
a bulleted list, the user suggested that the instructions for  
doing this be restated rather than asking the user to refer to 
the directions given for the numbered list, above. 

Nothing will be changed.  It is hoped 
that users will think to go back and 
reread the instructions if they are 
unsure how to complete step 5. 
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Lesson 2, 
Part 6 

User suggested that the words “absolute” and “relative” be  
bolded in the overview section to make them stand out more
 to the reader. 
 
Suggested that in step 4 in which the URL for the COE page
is given that the COE text in that sentence should actually  
be linked to the COE site. 

This change is not necessary.  
Italicizing the words is sufficient. 

Lesson 2, 
Part 7 

Typo found  in first paragraph in overview …left to right  
“ant” top to bottom… 
 
In step 2, on link colors, user suggested that there is a need  
to address what to do if default colors are different than 
those in the screen shots.  This question arose because  
the default colors were changed on that computer by prior  
to the evaluation taking place. 
 
User suggested to check to see if white is the designated  
default background color, because the screen was  
referencing gray as the background default color. 

Typo will be corrected and changed to 
“and”. 
 
Users will be given instructions to 
change the default colors if they are 
not correct. 
 
 
 
White is the default background color. 

Lesson 2, 
Part 9 

Check the spelling of bulleted. Composer spells it with 2 T’s but MS 
Word’s spell check spells it with only 
1. 

Final 
Assignment 

He completed all 11 criteria on the final assignment rubric 
correctly. 

 

Debriefing 
Questions 
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B.5 USER QUESTIONNAIRE DATA SUMMARY 
 

 
Users were asked to respond to each statement using the following scale: 
NA=Not applicable  1=Strongly disagree  2=Disagree  3=Neither agree/nor disagree  4=Agree   5=Strongly 
agree 
 
Questions User A User B 
1.  I was informed about the overall goal of this unit. 5 5 
2.  I was well informed about the specific objectives of this unit. 5 5 
3.  The language of this unit is clear and easy to understand. 5 5 
4.  This unit lived up to my expectations. 5 4 
5.  The content is relevant to my interests as an education major 
and as a future teacher. 

5 5 

6.  The instructions on how to use the unit are clear to me. 5 5 
7.  The unit objectives are clear to me. 5 4 
8.  The unit activities stimulated my learning. 4 5 
9.  The use of images is essential in the unit. 5 5 
10.  The activities in this unit gave me sufficient practice and 
feedback. 

4 5 

11.  The final assignment in this unit is fair. 5 5 
12.  The difficulty level of this unit is appropriate. 5 5 
13.  The individual lessons in this unit follow a logical 
sequence. 

5 5 

14.  The length of this unit is appropriate. 5 5 
15.  I accomplished the objectives of this course. 5 5 
16.  I will be able to use what I learned in this course. 5 5 
17.  This self-paced tutorial is a good way for me to learn this 
content. 

4 5 
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B.6 RECOMMENDED REVISIONS 

 The formative evaluation for this instruction on creating a web page with 
Netscape Composer yielded very valuable information including a few major 
recommendations for revision and several minor recommendations.   The major revisions 
include creating an all inclusive resources page, expanding the introduction to include 
new material, and creating additional sections for more advanced information.   

First, an all-inclusive resources page should include examples or descriptions of 
good and bad web design, fast and slow loading pages, example of good education web 
sites, information about how to FTP, and sites for further information on web 
development.  The expert evaluator stressed the importance for students to understand 
good web design and development concepts, especially at this beginning stage. The 
examples of good/bad web design and fast/slow loading pages would be valuable to 
students because a majority will have little/no previous knowledge of what those terms 
and factors mean in relation to web design. The examples of good education web sites 
will help students relate the skill they are learning to their future profession, and the sites 
for further information will be a good reference for those students wishing to learn more 
than what is presented in the unit.  The interspersing of this information throughout the 
unit would tie in the importance of these issues to the creation of teacher web pages, 
while providing a scaffold as the students complete these lessons. 

Second, the introduction section should be expanded to include information on 
how web sites work, how different web documents relate, and how search engines work.  
The SME evaluator teaches courses on web development and suggested that these topics 
are very important to teach students new to web design and development.  These topics 
are introduced in previous units in this course, however, the re-introduction of this 
material will provide a scaffold for students who need to review their prior knowledge. 
Once students understand the structure and underpinnings of web sites and the Internet, 
they can grasp the web development concepts more quickly.  This is also a good area to 
include further information about why web development skills are important for COE 
students and how educators can use web sites.  Without a section to convey this 
information, students’ motivation levels to learn this skill may be low.   

Finally, an additional section should be added at the end of the unit to include 
more advanced technical skill information, such as how to upload a web site to the 
Bengal server using FTP and Telnet.  This information is crucial in order to actually 
publish a web site, but it is more advanced than skills offered by the present course 
content.  Students intent on learning more about web page development will require this 
knowledge, and because the uploading procedures at UMC are specific, it would be 
important to include the instructions for doing so in this unit. Although students are not 
asked to FTP their final web page, those who wish to go beyond the requirement will 
have ready access to the procedural information necessary. This scaffold provides for a 
sort of “extension activity”. 

There are several minor revisions to be made to the instructional materials.  There 
are only a few typing mistakes to be corrected.  The HTML tag descriptions need to be 
better explained.  The expert and users complained about the wording on the HREF tag 
and the HEAD tag examples.  Within the tag descriptions, reference should also be made 
to the sample code because the users were confused until they noticed the sample code.   

The instructions for inserting elements should be rearranged so that the user is 
presented with using the toolbar buttons to insert elements before the pull-down menu 
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method is described.  The toolbar button method is the easier of the two, so it should be 
presented first.  The page layout may also need to be modified so that the images of the 
buttons and menus do not fall within the paragraph, but rather out to the side.   

The wording used in several areas needs to be revised. The information about 
relative and absolute links and web graphic formats needs to be improved (details in the 
observation logs).  Both users asked several clarifying questions about the different link 
types and using the link properties window to create links.  Users also requested 
clarification and examples of the different web graphic formats.  Therefore, better 
descriptions and examples of the different graphic formats need to be included.  The 
instructions on changing page colors and properties will also be clarified.  In user testing, 
it was found that the correct menu did not always open to the front when an action was 
performed.  Additional instructions need to be included in case of that situation. 

The screen shots for the default link colors will also need to be changed. The 
active link color should be red instead of blue by default.  Additionally, more information 
needs to be included about good and bad web design principles.  This subject alone is 
lengthy, so the additional information should be kept to a minimum, however the expert 
and the users all suggested more information be included on web design principles.  This 
information can also be linked to the examples of web design that will be included in the 
new resources page.   

The final assignment needs to be modified so that the web page the user develops 
is something he or she might actually be proud of, and able to use in the future.  While 
the expert felt the assignment was appropriate, both users felt the assignment was too 
simple.  Both users completed the final assignment with few questions in about five 
minutes, which might indicate that it was not challenging enough.  This cannot be fully 
determined until more users with low levels of experience in web development can 
evaluate the instruction materials. 
 There were also some recommendations drawn from the data analysis that will not 
be implemented.  Instructions for Macintosh users will not be incorporated at this time.  
Incorporating them would mean recreating nearly all of the screen shots on the Macintosh 
operating system.  This would greatly increase download time and the length of the 
pages.  Further user testing will help decide if textual instructions at the least will need to 
be added.  The expert suggested that more white space be used between screen shots and 
the directions and a bigger font be used.  This will not be implemented because the 
expert’s screen resolution was set to 1600x1200, which is why the instruction seemed so 
“cramped”.  However, in 800x600 screen resolution, there is usually only enough room to 
display a single screen shot and the instructions above and below it.  Therefore, the white 
space and font size will not be changed as most users will be using 800x600 or 1024x768 
screen resolution. Instructions will be included, however, that this unit should be viewed 
at a screen resolution of at least 800x600 and is best viewed at 1024x768. 
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Appendix C – Formative Evaluation Tools 
 
Appendix C contains all of the tools used in formative evaluation process.  The pretest 
and posttest, which are not included in the appendix, can be found in the instructional 
materials at http://courseinfo.coe.missouri.edu. The format for the One-to-One Data and 
Interpretation chart was taken from Smith and Ragan (1999).  The format for the attitude 
questionnaire was taken from instructional materials published by Dr. Thomas Reeves of 
the University of Georgia at http://it.coe.uga.edu/~treeves/edit8350/tools.html. 
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4.   Final Assignment Rubric……………………………………………… 73 
 
5.   User Evaluation Debriefing Questions………………………………... 75 
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C.1 USER EVALUATION OPENING 
 
 

ED101: HTML and NETSCAPE COMPOSER SKILLS 
USER EVALUATION OPENING 

 
Thanks again _____ for agreeing to help us evaluate this instruction.  This unit 

will be part of a course called ED101 that will be offered to freshmen COE pre-service 
teachers.  ED101 will be offered completely online.  The main goal of this course is to 
teach pre-service UMC-COE students basic computing skills.  Some of the skills covered 
in the course will be performing Internet searches, sending email, using Word, using 
Excel, using PowerPoint, and creating a web page with Netscape Composer.  As you 
know, the unit we will be looking at today is on creating a web page.  The lesson should 
take about an hour to an hour and a half to complete.  
 

This Netscape Composer unit is still being developed.  We really need your help 
to make these materials as good as possible.  You can help us the most by telling us 
exactly what you think of the materials.  If you think it is boring, too easy, too difficult, 
very helpful, or anything else, we would really like you to tell us.  You aren’t being 
graded on how well you do in this exercise and we won’t be upset if you don’t like 
something, so you don’t have to worry about anything.  Please just work through the 
lesson and complete the exercises as best you can.  It would also really help us if you 
could speak aloud as you go through the lesson.  Just say what you are thinking as you go 
through, and feel free to ask questions or make suggestions at any time.  This will really 
help us because we have looked at this so many times that it is hard for us to guess what 
it would be like to use it for the first time.  So by speaking aloud as you work, you will be 
giving us a lot of information about what it is like to do the lesson. 
 

Because ED101 will be online, you will use Blackboard to follow this tutorial.  
You will begin the unit by completing a little on-line survey that will tell us more about 
your web page knowledge and skills prior to this learning experience. Once you have 
completed this “Pre-Assessment” survey, you will be reading a set of instructions about 
navigating through the lesson on Blackboard.  Next, you will read a basic introduction to 
web pages and HTML.  Then, you will begin working through the Netscape Composer 
tutorial and learn how to make a web page.  After the tutorial, we would like you to 
create a simple web page of your own following a few guidelines.  After it is all finished, 
we would like you to complete a post-assessment quiz, and then fill out a brief 
questionnaire about the unit.  That’s it!  Do you have any questions for me before we 
begin? 
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C.2 ONE-TO-ONE DATA AND INTERPRETATION CHART 
 
User: 
Evaluated by: 
Date: 
 
When objectives are not referenced, information is being provided about a specific 
content area within the instructional materials that is not related to an objective.   
 

One-to-One Data and Interpretation 
Objective Data Source Information Gained Revision Decision 
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C.3 USER EVALUATION QUESTIONNAIRE  
 
 
Unit Name: ________________________    
Training Location: _______________________  
Participant Name (optional): ________________________________   
Date: _______________                          
 
Year in school:   Fresh     Soph     Jr     Sr    Gr  
 
INSTRUCTIONS: 
Please circle your response to the items.  Rate aspects of the course on a 1 to 5 scale, 
where 1 equals "strongly disagree" and 5 equals "strongly agree."  The number 1 
represents the lowest and most negative impression on the scale, 3 represents an adequate 
impression, and 5 represents the highest and most positive impression.  Choose N/A if the 
item is not appropriate or not applicable to this course.  Your feedback is sincerely 
appreciated.  Thank you.   
 
A. UNIT CONTENT:   (Circle your response to each item.) 
NA=Not Applicable  1=Strongly Disagree  2=Disagree  3=Neither Agree/Nor Disagree  4=Agree   
5=Strongly Agree 
 
1. I was informed about the overall goal of this unit.     N/A   1     2     3     4     
5 
Comments: 
 
2. I was well informed about the specific objectives   N/A   1     2     3     4     
5 
 of this unit. 
Comments: 
 
3. The language of instructional materials within this N/A   1     2     3     4     
5 
 unit is clear and easy to understand. 
Comments: 
 
4. This unit lived up to my expectations.   N/A   1     2     3     4     
5 
Comments: 
 
5. The content is relevant to my interests as an education  N/A   1     2     3     4     
5 
 major and as a future teacher.  
Comments:   
 
 
 
B. UNIT DESIGN:   (Circle your response to each item.) 
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6. The instructions on how to use the unit are clear to me.  N/A   1     2     3     4     
5 
Comments: 
 
7. The unit objectives are clear to me.   N/A   1     2     3     4     
5   Comments: 
  
8. The unit activities stimulated my learning.   N/A   1     2     3     4     
5 
Comments: 
  
9. The use of images is essential in the unit. N/A   1     2     3     4     
5 
Comments: 
 
10. The activities in this unit gave me sufficient   N/A   1     2     3     4     
5 
 practice and feedback. 
Comments: 
 
11. The final assignment in this unit is fair.   N/A   1     2     3     4     
5 
Comments: 
 
12. The difficulty level of this unit is appropriate.   N/A   1     2     3     4     
5 
Comments: 
 
13. The individual lessons in this unit follow a logical  N/A   1     2     3     4     
5 
 sequence. 
Comments: 
  
14. The length of this unit is appropriate.   N/A   1     2     3     4     
5 
Comments: 
 
 
C. SELF-PACED DELIVERY:  (Circle your response to each item.) 
 
15. This self-paced tutorial is a good way for me to learn this  N/A   1     2     3     4     

5 
content. 

Comments: 
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NA=Not applicable  1=Strongly disagree  2=Disagree  3=Neither agree/nor disagree  4=Agree   5=Strongly 
agree 
 
D. UNIT RESULTS:   (Circle your response to each item.) 
 
16. I accomplished the objectives of this course.    N/A   1     2     3     4     
5 
Comments: 
  
17. I will be able to use what I learned in this course. N/A   1     2     3     4     
5 
Comments:  
 
   
 
 
 
 
 
18. How would you improve this course?   (Check all that apply.) 
___Provide better information before course.       
___Clarify the course objectives. 
___Reduce content covered in course.                  
___Increase content covered in course 
___Improve the practice items in the course.        
___Make course activities more stimulating.  
___Improve course organization.                                 
___Make the course less difficult.  
___Shorten the length of the course.                            
___Make the course more difficult    
___Add more images to the course.                            
___ Improve the final quiz in the course.  
___ Improve the final assignment in the course. 
Comments: 
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C. 4 FINAL ASSIGNMENT SCORING GUIDE 
 
 

Visual and Textual Elements Points Earned 
1. The web page has a title. (1) 
 

            0                1 
 

 

2. There is at least one heading in the web page. (1) 
 

0                1 
 

 

3. There is one example of bold text. (1) 
 

0                1 
 

 

4. There is one example of italicized text. (1) 
 

0                1 
 

 

5. The web page has a numbered OR bulleted list of at 
least three items. (1) 
 

0                1 
 

 

6.  There is a horizontal line at the bottom of the page 
followed by “Authored by” and your name. (3) 
 

0                1                   2                  3 
 

 

7. There are two absolute links to educational web sites. 
(2) 
 

0                1                   2 
 

 

8. There are at minimum 5 relative “empty” links. (5) 
 

0               1             2              3              4               5 
                         

 

9. The background color is not white OR there is an image 
for the background. (1) 
 

0                1 
 

 

10. There is one educationally appropriate image included 
in the web page. (1) 
 

0                1 
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11. All of the files for the web page are stored in a folder 
with the user’s name on the C drive. (1) 
 

0                1 
 

 

Content Elements  
12. Teacher name is stated in the web site. (1) 
 

0                1 
 

 

13. Identification: Classroom room number, school name, 
and school location (City, State) is included. (3) 
 

0                1                   2                  3 
 

 

14. Grade Level and/or Subject Area and/or Specialization 
are stated in the Web Site index page. (1) 
 

0                1 
 

 

15. A rationale statement explaining the resources found 
within absolute and relative links in the body of your web 
page. (7) 
 

0        1          2          3           4           5          6          7 
 

 

          
 

You have successfully earned ___/ 29 points. 
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C.5 USER EVALUATION DEBRIEFING QUESTIONS 
 
1.  Did you enjoy the unit? 
 
 
2.  Do you think you have the ability to create a web page on your own after this unit? 
 
 
3.  Do you think being able to create a web page is an important skill for freshmen COE 
students to have? 
 
 
4.  Are there any parts of the units or of the instruction that need to be better explained or 
clarified? 
 
 
5.  What is least valuable about this unit? 
 
 
6.  What is most valuable about this unit? 
 
 
7. What other improvements would you recommend in this course? 
 



 77

Appendix D – Formative Evaluation Data 
 

Appendix D contains all of the data collected during the formative evaluation. 
 
 

1.   User A Data and Interpretation Chart……………………….…............ 77  
 
2.   User B Data and Interpretation Chart ……………………....…………  80 
 
3.   Pretest and Posttest Results .………………………………………….. 84  
  
4.   Questionnaire Data Summary………………………………………… 85 
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D.1 USER A DATA AND INTERPRETATION CHART 
 
User: User A 
Conducted by: Sarah LaVaute 
Date: May 3, 2002 
When objectives are not referenced, information is being provided about a specific 
content area within the instructional materials that is not related to an objective.   
 

One-to-One Data and Interpretation 
Objective Data Source Information Gained Revision Decision 
 Pretest/Posttest The subject struggled with 

the ordering questions, 
numbers 6 and 15.  She did 
not fully complete either 
question in the pretest.  She 
also indicated that she was 
a “visual learner.” 

These questions may 
be too difficult to 
answer without visual 
aids.  They should 
either be revised or 
removed.  

 “Instructions”  Arrows used clearly note 
the use of navigation tools. 

N/A 

 “Instructions” The graphic which shows 
the exact same navigation 
options, as shown above in 
the page is confusing. 
These are images – not 
able to use for navigation. 

It will be noted that 
the graphic image of 
the navigation choices 
are an example to 
reference for further 
understanding. 

Lesson 
Objective 1 

“Excursion” 
Lesson 1:  
Intro to HTML 

User stated that she liked 
this option for further 
information. 

N/A 

Lesson 
Objective 1 

Lesson 1: Intro to 
HTML 

Examples made sense. 
Subject stated that she is a 
visual learner, so the 
pictures really helped make 
it clear, “how it worked”.  

N/A 

Lesson 
Objective 2 

NC: Part 1 
Preparing to 
Create A Web 
Page 

Subject completed content 
related to this objective 
section with no comments 
and/or problems. 

None 

Lesson 
Objective 11 

“Excursion” 
NC: Part 1 
Preparing to 
Create A Web 
Page 

Subject stated that she 
enjoyed reviewing the 
resources offered about the 
teacher web pages. 

N/A 

 NC: Part 1 
Preparing to 
Create A Web 
Page 

Subject had problems 
navigating. 

None – this was 
attributed to her 
novice level of tech 
knowledge. 

Lesson 
Objective 3 

NC: Part 2 
Create, Name, 

Subject had problems 
accessing the “C” drive 

None - this was 
attributed to her 
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and Save an 
HTML Document 

and titling the folder 
correctly. Subject 
attempted to create a folder 
three times, the third time 
was successful.  

novice level of tech 
knowledge, and the 
fact that she was 
rushing through the 
lesson. Upon slowing 
down the pace, and 
rereading the content, 
the user was 
successful. 

Lesson 
Objective 4 

NC: Part 3 
Adding and 
Formatting Text 

Subject identified a 
discrepancy in the 
appearance of the screen 
shot versus her actual NC 
page document. The text 
size within the screen shot 
was larger than the actual 
NC page, which she was 
creating. The images did 
not look the same, although 
the text settings were the 
same.   

Present screen shots in 
this section, relating to 
the text elements, will 
be removed and 
replaced with screen 
shots which are an 
accurate visual of what 
the user’s page should 
look like. 

Lesson 
Objective 5 

NC: Part 4 
Creating 
Numbered and 
Bulleted Lists  

Subject did not complete 
“Step 3” correctly, by 
spacing as instructed.   

None – Subject had 
not followed 
instructions. Subject 
went back and self-
corrected herself 
successfully after re-
reading the 
instructions. 

Lesson 
Objective 6 

NC: Part 5 
Adding 
Horizontal Lines 
to Your Page 

Subject completed this 
section with no comments 
and/or problems. 

None 

Lesson 
Objective 7 

NC: Part 6 
Adding Links to 
Your Page 

Subject completed this 
section with no comments 
and/or problems. 

None 

Lesson 
Objective 8 

NC: Part 7 
Changing the 
Background, 
Text, and Link 
Colors 

Learner stated everything 
was very clear and easy to 
follow. 

N/A 

Lesson 
Objective 9 

NC: Part 8 
Inserting an 
Image into a Web 
Page 

Subject skipped through 
the first steps, reading each 
step as she went. She then 
went back and completed 
the steps slowly and 
accurately. 

N/A 

Lesson NC: Part 9 Subject completed this None 
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Objective 10 Previewing Your 
Web Page 

section with no comments 
and/or problems. 

Lesson 
Objective 11 

NC: Part 10 
Designing Your 
Own Web Page 

Subject did not look 
through all links because of 
time constraints. Subject 
stated that she liked 
number of resources 
offered and that it was not 
overwhelming. Subject 
stated that the number of 
resources available gave 
students choices that would 
result in a greater variance 
in their final web pages 
design and content choices. 

None – The time 
limitation issue will 
not be a problem 
during regular student 
use. 

Lesson 
Objective 11 

“Creating a Web 
Page” 
Assessment 

Subject completed this 
section with no comments 
and/or problems. 

None 
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D.2 USER B DATA AND INTERPRETAION CHART 
 
User: User B 
Evaluated by: Brice Jewell 
Date: May 4, 2002 
 
When objectives are not referenced, information is being provided about a specific 
content area within the instructional materials that is not related to an objective.   
 

One-to-One Data and Interpretation 
Objective Data Source Information Gained Revision Decision 
 Pretest/Posttest 

 
 
 

Subject said question 6 was 
too complicated.  Subject 
did not complete it in the 
pretest and was clearly 
frustrated with it on the 
posttest. During the 
posttest, he said he could 
complete the task if he was 
using the program, but the 
couldn’t remember the 
names that were used. 

Further testing will be 
needed to determine if 
an adjustment should 
be made.  This 
question may be 
simplified or removed. 

 Pretest Like question 6 mentioned 
above, the subject said 
question 15 was too 
complicated.   

Further testing is 
needed to determine if 
a change should be 
made.  This user may 
just be impatient. 

 “Instructions” Subject said he frequently 
has to use Mac computers 
in the Reflector. 

Keyboard instructions 
will be added for Mac 
users, but screen shots 
on the Macintosh 
operating system will 
not be added because 
the download time and 
length of each page 
would be greatly 
increased. 

Lesson 
Objective 1 

“Excursion” 
Lesson 1:  
Intro to HTML 

User stated that the 
example of the badly 
designed site was really 
good.  He suggested we 
explain why one is bad and 
why one is good.  

This is simply an 
introductory activity 
designed to gain 
attention.  No further 
explanations will be 
added at this point in 
the instruction. 

Lesson 
Objective 1 

Lesson 1: Intro to 
HTML 

Subject quickly went 
through this section.  He 
spent time comparing the 
image of the web page to 

None 
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the HTML code.  He 
skipped the Excursion at 
the bottom of the page. 

Lesson 
Objective 2 

NC: Part 1 
Preparing to 
Create A Web 
Page 

Subject quickly completed 
the tasks in this lesson with 
no difficulty. 

 

Lesson 
Objective 11 

“Excursion” 
NC: Part 2 
Create, Name, 
and Save an 
HTML 
Document. 

Subject read the Excursion, 
but did not follow the 
links.  Subject stated that 
he knew how web pages 
worked. 

Subject seems to be 
skipping and not 
spending much time 
on the Excursion 
sections.  Is there a 
way to encourage the 
students to look at 
them more carefully? 

Lesson 
Objective 3 

NC: Part 2 
Create, Name, 
and Save an 
HTML Document 

Subject noted a typing 
mistake in item 6. 

It should read, “After 
you save the file.” 

Lesson 
Objective 4 

NC: Part 3 
Adding and 
Formatting Text 

After completing this 
section, the user asked the 
evaluator if there were any 
sources that discussed 
appropriate fonts for the 
web.   

This was a very useful 
comment.  Information 
will be added to 
address this point 
either as text within 
the document or 
through external links. 

Lesson 
Objective 5 

NC: Part 4 
Creating 
Numbered and 
Bulleted Lists  

The subject scrolled to the 
bottom of the page to see 
the final screen shot and 
began trying to create it 
without reading the 
instructions above.  When 
he became confused trying 
to switch from a numbered 
to bulleted list, he returned 
to the top to read the 
instructions.  He 
commented that the screen 
shots were very good and 
helpful in completing the 
lessons. 

None.  This user is 
simply more advanced 
and trying to quickly 
complete the lesson. 

Lesson 
Objective 6 

NC: Part 5 
Adding 
Horizontal Lines 
to Your Page 

Subject completed this 
section with no comments 
and/or problems. 

None 

Lesson 
Objective 7 

NC: Part 6 
Adding Links to 
Your Page 

Subject did not read the 
Excursion section.  Subject 
completed this section with 

None 
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no comments and/or 
problems. 

Lesson 
Objective 8 

NC: Part 7 
Changing the 
Background, 
Text, and Link 
Colors 

Subject asked why some 
menu headings and buttons 
are bolded in the 
instructions but Enter in 
“Press Enter” is not. 

The instruction will be 
reviewed and all 
instances of keystrokes 
will be bolded for 
consistency.  If other 
keystrokes and mouse-
clicks are highlighted 
in bold, then changes 
like making “Enter” 
bold should be made 
as well. 

Lesson 
Objective 11 

“Excursion” 
NC: Part 7 
Changing the 
Background, 
Text, and Link 
Colors 

Subject spent several 
minutes using the color 
picker.  He said that was a 
very useful web site.  He 
also said the examples on 
background colors were 
useful.  He said he thinks 
there are a lot of people 
that don’t realize how 
important color choices 
are. 

None 

Lesson 
Objective 9 

NC: Part 8 
Inserting an 
Image into a Web 
Page 

Subject completed this 
section with no problems. 

None 

Lesson 
Objective 10 

NC: Part 9 
Previewing Your 
Web Page 

Subject completed this 
section with no comments 
and/or problems. 

None 

Lesson 
Objective 11 

“Excursion” 
NC: Part 9 
Previewing Your 
Web Page 

Subject thought the 
pictures of page layouts 
were very good.  He 
suggested creating a 
picture or template like that 
for a teacher web site. 

None – The aspects of 
this unit that deal with 
web design and 
content are supposed 
to be gained through 
discovery learning.  It 
is hoped that students 
will create their own 
mental picture of what 
a teacher site should 
look like. 

Lesson 
Objective 11 

NC: Part 10 
Designing Your 
Own Web Page 

Subject did read the 
headings in each section 
and some of the 
descriptions, but did not 
look at any sites until he 
got to the teacher web site 

None 
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examples.  He said the 
more examples of good 
teacher sites that could be 
provided, the better it 
would be for students. 

Lesson 
Objective 11 

NC: Part 11 
Additional 
Resources 

Subject quickly skimmed 
the list of resources. 
Subject noted that in 
previous links to web sites, 
the pages opened in new 
windows, but the links on 
this page opened within 
Blackboard. 

The source code of 
this page will be 
changed so that all 
links open in new 
windows. 

 NC: Part 12 
Putting Your Site 
Online 

Subject said this 
information was very 
useful and requested a hard 
copy of it so that he could 
upload his web pages in the 
future. 

None 

Lesson 
Objective 11 

“Creating a Web 
Page” 
Assessment 

Subject used Mrs. Ross’ 
First Grade Class web site 
as an example for the final 
assignment.   He used 
center alignment and 
spaces to create the table of 
contents.  He completed 
the assignment with no 
problems. 

The table of contents 
on Mrs. Ross’ First 
Grade Class web site 
used tables for layout 
purposes.  A unit on 
creating tables in 
Netscape Composer 
should be added to the 
instruction. 

 “After 
instruction” 

After completing the 
instructional materials, the 
subject asked if it would be 
possible to use videos of 
the tasks instead of screen 
shots.   

This option will be 
explored.  Video will 
probably not be used 
entirely, but it could 
be used to supplement 
the instruction.  The 
primary concern with 
using video is the 
length of the download 
time needed to view a 
video clip. 
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D.3 PRETEST AND POSTTEST RESULTS 
 
Incorrect Answers are indicated in red. 
 
  USER A USER B 
Question Correct Answer Pretest Posttest Pretest Posttest 

1 4 1 4 4 4 
2 2 4 2 4 2 
3 C,A,B,D D,A,B,C C,A,B,D D,A,B,C C,A,B,D 
4 1 1 1 1,4 1 
5 4 2 2 4* 3* 
6 4,5,2,1,7,3,6 -,4,5,-,1,2,3, 7,4,3,1,2,6,5 -,3,5,-,1,2,4 4,5,7,1,2,3,6 
7 2 4 4 4 2 
8 All 2,4 All All All 
9 1,3 1,2 1,3 1,2,3 1,3 
10 3 2 3 3 3 
11 1 3 1 4 1 
12 4 1 4 1 4 
13 white white white white white 
14 A,B,C A,B,C A,B,C A,B,C A,B,C 
15 6,1,4,5,2,3 ------ 6,1,4,5,2,2 6,2,4,5,1,3 6,1,4,5,2,3 
16 C,A,B C,B,A A,B,C A,C,B C,A,B 

 
*The correct answer was marked incorrectly in the quiz key.  3 is actually the correct 
answer to this question. 
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D.4 QUESTIONNAIRE DATA SUMMARY 
 

Users were asked to respond to each statement using the following scale: 
NA=Not applicable  1=Strongly disagree  2=Disagree  3=Neither agree/nor disagree  4=Agree   5=Strongly 
agree 
 
Questions User A User B 
1.  I was informed about the overall goal of this unit. 5 5 
2.  I was well informed about the specific objectives of this unit. 5 5 
3.  The language of this unit is clear and easy to understand. 4 5 
4.  This unit lived up to my expectations. 5 4 
5.  The content is relevant to my interests as an education major 
and as a future teacher. 

5 5 

6.  The instructions on how to use the unit are clear to me. 3 4 
7.  The unit objectives are clear to me. 4 5 
8.  The unit activities stimulated my learning. 4 4 
9.  The use of images is essential in the unit. 5 5 
10.  The activities in this unit gave me sufficient practice and 
feedback. 

4 4 

11.  The final assignment in this unit is fair. 5 5 
12.  The difficulty level of this unit is appropriate. 5 3 
13.  The individual lessons in this unit follow a logical 
sequence. 

5 5 

14.  The length of this unit is appropriate. 4 4 
15.  This self-paced tutorial is a good way for me to learn this 
content. 

5 5 

16.  I accomplished the objectives of this course. 4 5 
17.  I will be able to use what I learned in this course. 5 4 
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